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Preface

The aim of secondary education is to make the learners fit for entry into higher
education by flourishing their latent talents and prospects with a view to building the
nation with the spirit of the Language Movement and the Liberation War. To make the
learners skilled and competent citizens of the country based on the economic, social,
cultural and environmental settings is also an important issue of secondary education.

The textbooks of secondary level have been written and compiled according to the
revised curriculum 2012 in accordance with the aims and objectives of National
Education Policy-2010. Contents and presentations of the textbooks have been selected
according to the moral and humanistic values of Bengali tradition and culture and the
spirit of Liberation War 1971 ensuring equal dignity for all irrespective of caste and
creed of different religions and sex.

Honorable Prime Minister, Government of the People’s Republic of Bangladesh,
Sheikh Hasina expressed her firm determination to make the country free from illiteracy
and instructed the concerned authority to give free textbooks to every student of the
country. National Curriculum and Textbook Board started to distribute textbooks free
of cost since 2010 according to her instruction. In its continuation, this textbook has
been reviewed and updated with a view to create a developed and resourceful Bangladesh
keeping vision 2041 ahead.

The government has been working hard to make the life of the people of Bangladesh
easy, comfortable and cheerful by implementing the Digital Bangladesh using
information and communication technology based education. So, Information and
Communication Technology subject has been made compulsory from class VI to XII
in the National Education Policy. To give the purpose forward the curriculum and
textbook have been developed. We hope this textbook will impart information and
communication technology literacy to the students and develop in them a keen
interest that will play an effective role in making Digital Bangladesh.

I thank sincerely all who were involved in the process of revision, writing, editing,
art and design of the textbook for their intellectual labour.

Professor Md. Farhadul Islam
Chairman
National Curriculum and Textbook Board, Bangladesh.
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First Chapter

Information and Communication Technology
and Our Bangladesh
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After cumpleﬂng this chapter we will be able to—
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explain the significance of ICT;

explain the conttibutions of the people related with ICT;
explain the importance of e-leatning in Bangladesh;
explam the necessity of e-governance in Bangladesh;
axplam the importance of e-service in Bangladesh;
axplaim the importance of s~-commeres in Bangladesh;
analyse the progpect of ICT in job-sectors in Bangladesh;
explain the role of ICT in aocial networking;

explain the positive aspects of ICT in entertainment;
explain the future image of an ICT oriented Bangladesh;
design a poster on an ICT oriented Bangladesh,
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The 21st Century and Information and Communication Technology

The concept of weslth that prevailed in the last century has radically changed.
The whole world rightly acknowledges that the wealth of the 21% century is
knowledge. It means that neither agriculture, mineral resources and energy, nor
industry and business are the sources of wealth. Human beings are because they
are capable of searching knowledge. This concept has reshaped the people's way
of thinking throughout the world. They have been taking preparations to face the
challenges of the 21st century.

We have already started realising that the world of the 21st century is making its
firm standing on a knowledge-based economy. In this century, two more
important factors - globalisation and internationalization have come into being,
and ICT is the main driving force behind their acceleration. Now the
geographical border of a country transcends and extends to all parts of the world
as an effect of plobalisation. We can refer to Bangladesh a5 an example to make
the point clear. Millions of Bangladeshis now live all over the world, The place
where they live in is as if a small Bangladesh. So, in one sense, the border of
Bangladesh has extended beyond its own one. Moreover, they, in spite of being
the natives of Bangladesh, are living as the citizens of different countries,
Internationalism’ is the unwritten law of the present world.

Once people had to depend on the blessings of nature for survival. However, by
inventing machines and tools, they have lesgened this dependence. With the help
of machines and technology, they have controlled the world economy after the
Industrial Revolution in the 18th and 19th century. The nations, which
participated in the industrial revolution, once ruled the world. A similar ghift of
power haz been observed, as the knowledge-based economy has started

dominating the world in the 21at century. L -1
We can realise that we should take ol

adequate preparation for taking part in this
revohution. The specific skills for survival g
are the ability fo cooperate and
communicate with cach other, awareness [y
about the obligations of the citizenry,
acumen in solving problems, critical
thinking, creativity, and skill in ICT,

ICT Competition
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In fact, skill in ICT has emerged as the most important technological skill.
Everyone should have the bagic computer literacy to survive in the 21* century.
Only then, one may have access to its amazing world. Unless students acquire
the ICT =kills, they may not generate new knowledge by collecting, analysing,
and evaluating information. In fact, without the skill, they can never face the
challenges in the 21® centyry and position themselves in the knowledge based

gocicty.

Great ICT Personalities

Many scientists, visionaries and engineers have
contributed significantly to the development of
Information and Commumnication Technology. Cable
connection and the wireless system, acceleration of
computers' counting power and the development of
microelectronics have ensured rapid growth of ICT.
Charles Babbage (1791-1871), an English engineer
and mathematician, first introduced and developed
computer, He is regarded as the father of the modern
computer. He invented Difference Engine In 1991, in
the Science Museum of London, an engine was made
according to the design of Babbage, and it worked
properly as expected and later, he designed a

Charles Babbage

calculating machine called

2023

Analytical Engine.

Ada Lovelace (1815-1852), the daughter of poet
Lord Byron, first thought about how the process of
calculation could be made more effective. She
became interested in science and mathematics since
her childhood and wag encouraged by her mother.

| | When she met Charles Babbage in 1833, she

brought before him the concept of ‘programming” to
use in his analytical engine. That is why Ada
Lovelace iz honoured as the pioneer of
programming concept. Babbage delivered a lecture
about his engine in 1840 at Turin University. Then

' | Ada with the help of Babbage, explained the ways

how the engine could work. She marked it in a



4 Information and Communication Technology

mimerical order, while describing its mode of working, In 1953, when the note
was published agam one hundred years after the death of Ada, the scientist
realized that it was Ada who put forward the idea about the Algonithm of
programming.

Important progress was made in physics during
that period with the inventions of Babbage and
Ada. Scientist James Clerk Maxwell (1831-1879),
combining the electric energy and magnetic force,
put forth the theory of Electromagnetic Force
which opened a possibility of sending wireless
messages from one place to another.

.| Bengali  scientist
Jagadish Chandra
Bose (1858-1937) James Clerk Maowell

™ | became successful for the first time in gending
| | wireless messages from one place to another. In
1895, he successfully did it by using microwsve.

| | But, Italian scientist
Guglielmo Marconi
(1874-1937)
succeeded first in
Jagadish ChendraBose | d0ing the same work
by radiowave. That is
whiy he is acknowledged ag the inventor of radio.

In the 20th century,
f| after the development

of clectronica, IBM
|| Company was the first
to build the mainframe Guglielmo Marconi
computer after the
development of electronics. In 1971, cost-saving
computers were made, With the invention of the
microprocessor, it became easier to make affordable
computers. In the 60s and 70s, using the Intemnet

2023
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Protocol, Arpanet was invented. The inter connection among the computers
through network started developing since then, and the invention of the imternet
was the outcome. In 1971, American programmer Raymond Samuel Tomlinson
introduced the first electronic mail communication through ARPANET. He is
the pioneer of inventing the ¢-mail gystem,

After the invention of the microprocessor,
personal computer was made by using this
device in the USA. Steve Jobs (1955-2011)
and his two friends Steve Wozniak and
Ronald Wayne started a company named
Apple Computer on April 1, 1976. This
company is one of the biggest organisations
in the world. The development of the
personal computer has been carried out by
this company.

IBM company put the responsibility of
developing the operating system for
personal computers on “Microsoft’ of William
Henry Gates or Bill Gates (Born on October
26, 1955). They succesfully developed MS
DOS and Windows operating system. At
present, most of the computers of the world

Wllllarn.Henry are run by the operating system software of
Microsoft company of Bill Gates.

In 1989, during the development of the internet, a [gm
British computer scientist proposed and later on ||

successfully invented information management by |FEFTY
using Hypertext Transfer Protocol (hitp). Sir |F S
Timothy John Berners Lee is known as the
pioneer of the World Wide Web (WWW). For its
development the Internet technology spread out ||
throughout the world, A strong economic field has
been created on the Internet and different types of -
application software have been developed. Timothy John Berners Lee
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The most popular social networking system in the
world is Facebook. A student of Harvard University,
Mark Zuckerberg (Born on May 14, 1984) and his
four friends are the pioneers of creating the social
networking system Facebook. At first, it was used
only by the university students. But now many people
of the world are using Facebook. Many people in our
Bangladesh use Facebook for social networking
too.

Mark Zuckerberg

E-learning and Bangladesh

For years, knowledge has been acquired across the world in traditional methods,
The innovation and development of ICT have brought about changes for the first
time in these methods. We have becoms familiar with the terms like e-learning
and Distance Leamning E-leaming is the short version of electronic leaming
which basically means a teaching process by using CD-ROM, the Internet,
personal network and TV channels. However, we should keep in mind that
e-learning is not an alternative to the conventional way of learning. For example,
it ig hard to demonstrate in class different scientific and natiral phenomena, such
as, a solar eclipge, a hunar eclipse, and so on. A teacher may demongstrate these
phenomena with images, videos, and graphs with the help of multi-media. The
class can be interactive too.

Bangladesh has a huge population, and that is why the class size is usually big.
The schools in our country lack skilled teachers, teaching and learning materials,
science laboratories, etc. The students do not have a wide scope of doing
geientific experiments. E-learning can play a vital role to solve these problems,
A lesson conducted by a skilled teacher may be recorded and distributed to
huncreds of schools. Different learning materials for teaching a specific subject
can be given to students. Teachers themselves may make their lessons more
effective and these lessons may be reused in other classes. Many terchers of

Bangladesh are using e-learning materials.

Teaching and leaming materials are made for e-leamning all over the world.
Renowned universities of the world have introduced some online courses and
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anybody can take any of these courses. A learner can take the course either by
submitting his homework or sitting for examination online, and can get the
requisite credit. Research is going on to develop the field.

Bangladesh is not lagging behind in e-learning. The ICT specialists of the
country have opened some web portals offering courses in Bangla, and learners
from any part of the world can take the courses. The ICT oriented, specifically
training courses in computer programming, have earned popularity at home and
abroad.

E-learning can play a vital role in over-coming the limitations of teaching in
Bangladesh. However, it is not a substitute of the conventional teaching method
of a classroom in which teachers and students have face-to-face interactions,
exchange of opinions, and question and answer sessions. Moreover, students can
ask questions, interact, and help themselves in learning something. In addition,
teachers and students can assist each other in the learning process and optimise
their learning by peer-bonding. By contrast, possibilities of interactions are
minimal in e-learning. As e-learning requires little human participation, it may
become mechanical. Therefore, in order to make e-learning successful, students
need to be very pro-active. E-learning has a wide scope in Bangladesh as we can
minimise the limitations in classroom teaching by adopting e-learning.
However, implementation of e-learning practices in classroom will require fast
internet connectivity, necessary infra-structure, and e-learning materials. The
present Government is developing this type of teaching learning materials. It will

help our students to achieve Global standard.

Group Activity

Discuss in group and present how e-learning can play a vital role in the
development of education.

E-Governance and Bangladesh

Transparency and accountability are needed for a good governance. A modern,
transparent, and accountable governance can be ensured by introducing a digital
system. It will ensure good governance, stop the harassment of the citizen, and
pave the way of good governance. The application of electronic or digital
method in the government administration is called e-governance.
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Once, it was very difficult for the examinees and their guardians to collect the
result of a public examination. It was even more difficult for the people living in
the remote villages. Even two decades ago they could not collect their results a
week after the publication of the result. Now they can get it either through the
internet or the SMS option of the mobile phone. So, the trouble of instantly
collecting the result has come to an end.

Another example of e-governance is the facility of submitting applications to the
higher educational institutions with the help of the mobile phone. Previously if a
candidate of Jessore wanted to apply to Shahjalal University of Science and
Technology, he had to complete a series of formalities. Candidates or their
representatives had to travel to Sylhet in order to collect and submit university
admission application forms. Now candidates may submit their applications
through mobile phones. They need not to travel from one city to another.

District offices of the Deputy Commissioners have E-service Centres in order to
ensure easy, affordable, and hassle-free services. Now a service delivery of a
services that took 2-3 weeks in the past now takes only 2-5 days. On top of it,
digitalisation of the information has reduced the time in decision making by.
Government departments have become transparent and accountable in
providing their services and increased their efficiency in issuing copies of deeds
and settlement records.

The manual process of paying gas, electricity and water bills is time-consuming
and troublesome. Sometimes the busy hours of a day are spent to pay the utility
bills. Now the bills can be paid either online or through cell phones. The target
of the Government is to ensure better life standards and a hassle-free life for its
citizens. E-governance has made some services accessible 24 hours a day, seven
days a week, 365 days a year. Some of these services, for example, are ATM
services, mobile banking, information services, etc. As a result, citizens may
avail the service at their convenience.

In addition, with the introduction of e-services and inter-departmental
communication, net-working within the Government has increased. Government
employees have also become skilled. As a result, providing faster service has
become easier.

2023



Information and Communication Technology and Cur Bangladesh 9

Bangladesh has introduced e-governance for a few years. E-service is yet to be
introduced to all sectors of the governance. With its succesgful implementation
in every sector, Bangladesh will certainly ensure good governance.
E-Service and Bangladesh

Many government and non-government BANGUATES: AR
ﬂﬂr‘:’iﬂﬂ providing mﬁm provide .'-:'t;:".:_'".','.':':.:.':'....‘...':".:'.: e it o

the citizens with temporary and full tme | 7 . e e e e i ac e
services. This might be travelling from | __.. a—
one place to another or issuing duplicate | ~==="" ———

records of a land. Before the introduction | o -

of the digital system, the services seekers | == :

had to meet the service provider, but | =~

now they can receive the services through |

the internet or mobile phones while | Zooo :

staying at home. For example, they | .ooooecpocmom oo
can purchase tickets through the | EEcammic—inmue—
internet. or mobile phone. People, a few | =5

days ago, had to go physically to Kamlapur train station, and stand in the queue
before the counters for tickets. This system is still in practice, but now anyone
can collect tickets and pay the fares online. Providing services through an
electronic systemn is called e-service. E-gervice ensures availability of services at
low cost in the shortest possible time without much hassle. E-service has already
been introduced to several ministries, departments and directorates of the
Government of Bangladesh,

The digital edition of textbooks, e-szettlement records, e-permit, e-ticket,
telemedicine, e-tin registration and income tax calculation, etc. are the
examples of e-services.

A. E-permit: It is one of the primary e-services of the coumtry. The sugar cane
farmers of fifteen sugar-mills of the country get e-permit through the
message option of the cell phone. An e-permit is the official permission of the
gugar mills authority for the farmers to supply sugar canes at a fixed time,
The harassment of the farmers has come to an end as they receive the
information of supplying suger canes through SMS. The production of the
sugar mills has also been increaged due to timely supply of sugar canes,

Forma-2 ICT, S-10
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B. Electronic Money Transfer System (MTS): Money can be sent at a low
cost from one place to another quickly and safely through the electronic
money transfer system of the Bangladesh Postal Department. It is possible to
transfer BDT 50000 in one minute. This service is available in all
post-offices in Bangladesh.

C. E-settlement Records : The duplicate of land settlement records can be
collected through this service. Previously employees of the land settlement
department would supply the information to the applicants from big record
books after filling up the prescribed forms. The applicants had to be present
physically in the office and the employees of the concerned department
would prepare it manually. Because of the e-service, applicants at home and
abroad can receive the settlement records, paying the required fees.

D. E-healthcare: Physicians in government health centres give advice on
mobile phones. That is why government hospitals have been provided with
mobile phones. Any citizen of the country can get the advice of any
physician. Besides, in some hospitals, telemedicine service has been
introduced. Because of the telemedical services, patient in upazila may
avail the service and advice of medical specialists in district hospitals on
mobile phones.

E. E-tiketing and Mobile Ticketing of Railway: Tickets of some intercity
trains can be collected either through mobile phone or online. As a result,
travellers can purchase the ticket at their convenience without going to the
ticket counters of the railway station. They can reach the station just before
the departure of the train and collect the printed ticket from a particular
counter.

E-commerce and Bangladesh

There is no substitute for trade and business for the progress and creation of jobs
in a country. A change has been brought about in the business sector of
Bangladesh for the electronic innovation of digital technology and the internet
and exchanging process besides paper currency. Running a business through an
electronic medium is known as e-commerce.

There are some terms and conditions in business. Firstly, the sellers must have
the commodity. Secondly, the buyers will pay the price of the product. This
transaction requires direct communication of the seller and buyer. However, in
the era of internet, nowadays sellers may create a website and display the

2023
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images of their products. The buyers, after choosing the commodity, pay the
price and get it. The buyers have the facilities to pay the price through debit
and credit cards. They can pay through mobile banking even. Thirdly, on
receipt of the payment, the sellers either deliver the products themselves or by
the courier. Another payment method is through courier service after receiving
the price.

The bill payment can also be done in the Cash on Delivery (COD) method,
which is different from mobile banking and debit or credit card payment. The
purchaser choose the product from the website of the seller and orders for
supply. The seller after getting the order sends it to the buyer who pays the bill
after receiving it.

E-commerce has been gradually increasing in Bangladesh since 2011-12. Now
everything including books, garments, food, luxurious goods, etc. is sold or
bought through e-commerce. Two types of establishments are noticed in
e-commerce like a conventional business. One kind of establishment sells only
its own products and another kind sells the products of different companies. You
have already watched advertisements of some websites on the internet,
television and in the newspaper.

ICT in the Job Sector of Bangladesh

Nowadays, the multifarious use and impact of ICT in the job sector is noticed
in Bangladesh like other countries. The impact and capacity of ICT are
gradually increasing. Two types of impact of ICT are noticed. First, the
introduction of ICT in the prevailing working sectors has enhanced the skills of
the employees and extended the market. Second , ICT itself has created new
job-opportunities.

The use of ICT in the prevailing existing job sector and old business sectors, on
the one hand, has enhanced the efficiency, transparency and accountability of the
professional groups; on the other hand, has increased the standard of service.
Skill in ICT is now regarded as the elementary qualification for any job.
Employees of banks, insurance, multinational companies, and government
sectors need to be skilled in word processing, presentation software, internet
browsing, email management, analytical software, etc. In addition, they have to
develop expertise in a specific software product, such as banking software. On
top of it, ICT has created a large job market of making hardware, software,
developing websites, maintenance, etc. Now it is a big market for the skilled
workers who can work at home or abroad and set up their own ICT firms.
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A major part of the task can be accomplished at home. Many people earn
foreign currency for the country through outsourcing.

Social Networking and ICT

Social mobility and development require communication amongst individual
human beings. So, social communication means interaction among people
through virtual communication and networking. In other words, what people
create and exchange to communicate and express by using the internet and ICT
is called social networking. Now this communication has become easier,
cost-effective and usually safe. By using the internet, e-mail, mobile phone and
messaging system, blogging and platforms of social networking, the ICT based
social networking has been made easy. Platforms have been set up on the
internet, known as social networking. Such as Facebook, Twitter, LinkedIn, Instagram
etc. Two most popular social networking websites are Facebook and twitter.

« www.facebook.com: Facebook is a website of the social networking system.
Mark Zuckerberg along with some of his friends launched this site. Anyone
can be a member of Facebook without any subscription. The users can add
friends, send messages, update their personal information and give status and
share information with others. Besides, audios and videos can be sent through
it. Any organisation can open its home page on Facebook, and at the same
time, like-minded people can form a Facebook group. According to
www.stastica.com report of July-September 2018, the number of Facebook
users in the warld was 2.7 billion.

* www.twitter.com: Twitter is a social network too, but it has a basic difference
with Facebook. The users have to express themselves and exchange opinions
within 140 characters. That is why it can be called a website of micro
blogging. The message of 140 words is called the "Tweet'. The tweets of
Twitters are displayed on their profile page. The members of the twitter can
follow other members to read the tweets. Those who follow a member are
called followers.

Entertainment and ICT

With the development of ICT, a new era in the entertainment world has started.
It has occurred in two ways. First, how people consume entertainment has
fundamentally changed. Second, different media of entertainment have
qualitatively changed.

Let us see first how individual media consumption habit has transformed in
response to the changes in ICT. Once, people had to go outside for

2023
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entertainment. If they wanted to enjoy a film, they had to go to the cinema hall
to enjoy a film; to the playground to watch a football match; to a concert to listen
to music. Nowadays, there is no need to go outside for entertainment. Radio was
invented first, and then the television. The computer came eventually. The
Internet is the latest addition to the computer. We have discovered that people
can enjoy all kinds of entertainment within the four walls of their home. When
computer first came into being, it was only used for computation and
calculation. Only the big organisations and the government could afford
computers. However, with the development of technology, computers have
become easily available and people have started using them for their personal
purposes. Since computers have become more sophisticated with processors,
huge storage, and considerable memory, they can be used not only for writing or
calculation, but also for entertainment. Perhaps, people use computers mostly
for their entertainment. Composing a song, making a movie, and editing a
photograph - all can be done on computers. Because of the development of ICT,
changes have come to the media and forms of entertainment. Since songs can be
digitised and converted into MP3 format, they can be played on computers.
Similarly, we can watch videos and movies on computers. A huge volume of
data can be stored on CD or DVD. Watching movies on DVD players without
going to the cinema hall is a very common practice nowadays. Internet with
faster speed has become easily available due to 'fibre optic network'. As a result,
people do not have to depend on audio CD or DVD either for listening to music
or watching films. On top of it, programmes in different radio and television
channels can be directly accessed through the Internet. Sometimes recorded
programmes are also available on the Internet. Hence, viewers can access these
programmes according to their convenience.

New forms of entertainment have appeared with the development of ICT.
Computer games are one of them. Big industries of computer games have been
established all over the world and the experts of these industries are innovating
computer games of various sorts. The extensive popularity of computer games
demonstrates its immense success as a new medium of entertainment. One of the
reasons for their success is that computer games entertain people of all ages with
different preferences. These games can be played with others, the computer
itself, or even with gamers in a remote place via network. In fact, it should be
noted here that excessive and compulsive use of computer or video games may
become so strong that it can easily turn into an addiction. That is why
people around the world are warned about the negative consequences of
compulsive computer or video gaming. Development in ICT played a vital role
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in the emergence of new forms of entertainment. Once, making animation or
cartoon films was very difficult. It has become easier for ICT and high-end/
super computers. Not only that, innovations done by creative designers have
brought about changes to graphic works. Digital actors and actresses have been
created on computers for graphic movies that are no longer dependent on real
actors and actresses. Use of high-end/ super computers in creating imaginary
dinosaurs and aliens for popular commercially successful films is very
common nowadays.

In summary, ICT has not only created new forms of entertainment, but also
made them accessible to the mass. Most importantly, ICT has revolutionised
the entertainment industry and its ultimate future in the entertainment industry
is beyond one’s imagination.

Digital Bangladesh

The present government has undertaken a plan to establish ‘Digital Bangladesh’
for the first time. Bangladesh conquered its independence through enormous
bloodshed in the liberation war of 1971. We will be celebrating the golden
jubilee in 2021, and that is why we are determined to take our motherland to
the highest peak of success. ‘Digital Bangladesh’ is the means to materialise the
vision. The Government and general citizens have taken initiative to
materialise the dream.

First we should know what we mean by ‘analogue’ and ‘digital’. An analogue
signal is a kind of continuous and infinitely variable representation of data or
information. As an example, we may discuss about the measurement and
record of daily temperature. Temperature varies throughout the day and the
temperature inside the home can also be much different than the outside.
Representation of any small amount of change in the temperature through a
signal may be called an analogue signal. However, an analogue signal may not
always give information with precise accuracy and reliability.

A digital signal converts the information into numbers (digits) and displays and
stores the information in numbers. Hence, it is called the digital signal. Since the
digital signal indicates the value of the quantity in a digital format, that is, in a
numerical form, it gives more accurate information than the analogue signal.
It is generally quicker and easier to read than the analogue one. For example, a
watch, with a high-precision movement of an hour hand, a minute hand and a
second hand, gives an analogue signal as a measure of time passing. By
contrast, a watch, with an electronic display of time in numbers, gives a digital

2023
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signal. The phrase ‘Digital Bangladesh’ is not used to indicate Bangladesh as a
'Computer Oriented Country'. Its implication is more extensive. Digital
Bangladesh refers to a modem Bangladesh, developed with the help of ICT. The
objectives of Digital Bangladesh are to ensure better education and health and
more job opportunities and eradication of poverty. Therefore, in order to fulfill
these objectives, it is important to bring changes to our old conventional
mind-set and be positive and inventive. The fundamental aim underlying Digital
Bangladesh is to ensure democracy, human rights, transparency, accountability,
and justice with the maximum utility of technology. The main thrust of the
objectives is to improve the standard of living of citizens from all social classes.
In order to fulfill the objectives of Digital Bangladesh, the Government has
focused on four specific factors: human resource development, participatory
citizenship, civil services reformation, and inclusion of technology in everyday
life.

Bangladesh has started developing information and communication technology
late in comparison with other countries. That is why Bangladesh is significantly
lagging behind. Even though the significance of ICT was not realised, nowadays
ICT is getting proper importance. We are getting high speed internet connection
as we are connected to the submarine cable.

There is a positive side of the extension of technology. If a nation lags behind at
a moment in any particular technology, it does not mean it will stumble all the
time. It may leapfrog other countries. Bangladesh is trying her level best to be
equal with other countries in her use of technology.

The infrastructure for information technology has started to be constructed in the
country by the present government. Setting up the fibre optic connection
throughout the country, an initiative is taken to provide the internet service to
remote area. The number of telephone users was negligible in the country just
ago one and half decades, but now every adult uses a phone. Information service
centres have been opened at the union level, the post offices of the remote areas
are transformed into e-centres that provide the service of mobile money
transaction. The district information cell and the national information cell with
the union information centres are important additions to the infrastructure of the
country. The tasks like registration of admission test, getting the result of public
examination, and purchasing train tickets are being done regularly on the mobile
phone. ICT courses are included in the curriculum of schools and colleges. This
textbook is an example of that. Computer Science is being taught in the colleges
and universities. The younger generation of the country is joining the software
companies along with setting their own firms, and a large number of young
people are strengthening the economy of the country through outsourcing.
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12% May, 2018 is a very important day for us. In this day, Bangladesh, as 57®
state of the world, has launched its own satellite ‘Bangabandhu-1" in the space.
As a result we have moved one step ahead to digital Bangladesh. Bangladesh
will be benefited in the field of Education, Health, Agriculture, weather forecast
and economic advancement by using this satellite. This will be used in satellite
based television services as well as ensuring our National Security. For this
satellite it will be easy to spread internet and telecommunication facilities in the
remote areas of the country. By using Bangabandhu-1 Satellite, we will be able
to save and eam foreign currency in the Information and telecommunication
sector.

The success stories, however, do not indicate that we have reached our target.
We have to walk a long way to achieve the goal. As most of the people of our
country live in the villages, the first step to ‘Digital Bangladesh’ is to bring these
people to the network of ICT services. So, we have to build up large
infrastructures. A skilled manpower is required to avail of the opportunity of ICT
to the utmost level. So, we should develop expertise in this sector. The standard
of education of colleges and universities should be enhanced and a good number
of students should be skilled in ICT. Transparency should be ensured through
e-governance. The new generation should be encouraged to use their innovative
power, and a co-ordination between universities and information and
communication technology is must that we can make a real °‘Digital
Bangladesh’.

Activity
Design a poster about what to do for building up 'Digital Bangladesh'.

Exercise

1. In which year was London Science Museum successful in making the
engine capable of calculating mechanically?

A. 1833 B. 1842
C. 1953 D. 1991
2. Which scientist made it possible for us to do office from home?
A. Charles Babbage B. Ada Lovelace
C. James Clerk Maxwell D. Jagodish Chandra Bose
3. Who is the inventor of Facebook?
A. Steve Jobs B. Bill Gates

C. Mark Zuckerberg D. Tim Berners Lee
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4. Because of the use of ICT in government services —

1. government services can be easily accessed within the shortest

possible time;

ii. the standard of government services can be enhanced;

iii. government service can be availed even in holidays;
Which one is correct?

A i&ii B. i&iii

C. ii &iii D. i,1i & iii

Read the section below, and answer questions 5 & 6:

17

Shumon fell sick while on a pleasure trip at St. Martin. When he contacted a
doctor in Dhaka, he advised him to get himself admitted soon in a hospital. The
doctor of the nearby hospital arranged his necessary treatment after consulting

with a medical specialist in Dhaka.

5. The technology through which the local doctor can get advice of a specialist

doctor is_

1. tele-medicine
ii. E-healthcare
11i. E-commerce

Which one is correct?

A 1&ii B. i&iii
C. ii &iii D. i,ii & iii
6. Which technology played a vital role for the treatment of Sumon?
A. ICT B. Television
C. Robot D. Computer

7. Milon of Jadurchar, Roumari of Kurigram intends to obtain higher education

staying at home. How can ICT help him?

8. What possibilities have been created by ICT for solving unemployment

problem in Bangladesh? Explain.
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After completing this chapter, we will be able to —
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explain the importance of computer maintenance;

differentiate between software uninstallation and software deletion;
explain the importance of using password and anhi-virus for the security
of computer, data and software;

explain the difference between general and social sites;

analyse the consequence of the excessive use of the internet;
explain the negative aspects of playing games excessively,
describe the event of software piracy;

explain the importance of copyright law;

explain the necessity of security with reference to the free flow of
information in the internet;

expain the importance of troubleshooting in computers;

install and uninstall software following the right process;

prepare a unique password,

troubleshoot the usual problems of the computer,
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Importance of Software in the Maitenance of Computer

Story 1: Raina was very intent on having a laptop from her father after getting
admission to the college. As her attainment in the first term examination was
good, her father bought her a branded laptop with core i5 processor. Raina was
impressed with the quality and speed of the laptop. She installed many pieces of
software within a few days. However, she noticed a gradual decline in its
performance. After one year, she observed that the laptop was running too slow
and it was irksome working on the computer. After some days, she made a
capricious demand to her father for purchasing another one for her.

Story 2: Ankon has recently taken internet connection for the computer. Now he
frequently browses the Web and has benefitted greatly from the sites with the
information related to his study. Besides education, he uses the internet for
sending emails, listening to music, and watching movie. Recently he has found
the computer often restarting without any prior notification. In addition, the
internet browser opens different sites without any command. One day, he
inserted a memory stick into the USB connection port on his computer. He was
shocked to find out that his files turned into 'shortcuts'. He could not even locate
the original files.

What do you understand from the above events? Is it similar to your experience?
You have already known many things about Information and Communication
Technology this time, and you have understood that the processor and software
are the main components in ICT. A new computer, be it a desktop, laptop or
tablet, usually runs fast, but after some days, it gradually slows down. As it gets
old, it becomes slow. Sometimes, you have to wait for a long time after giving a
command. Sometimes the situation is so bad that you want to buy a new one.

What is the way to resolve this situation? Here lies the importance of computer
maintenance. You have to learn a little about computer maintenance in the junior
classes. Most of the people do not like the task of maintaining ICT or
technological devices. However, it is an important task. If you want to keep your
ICT device operative, you have to maintain it. You need not to be an expert for
that job. We are talking about software-oriented maintenance of ICT devices.
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If the Windows Operating System of Microsoft Company is used in your ICT
device (in almost all the computers of the world, Windows Operating System is
used), you have to check its status and update the operating system all the time.
If the device is connected to the internet, the updates are done automatically.
Other operating systems provide a similar kind of facilities too. In spite of that,
you have to use registry clean up software to keep the machine fast. If you do not
use this software, your machine will not work properly and it will be a matter of
annoyance for you.

Besides, whenever the computer is used, some temporary files are created. If
these files are not erased for a long time, they occupy a lot of space in the hard
disk and slow down the speed of the computer. That is why we should erase the
temporary files with a software. It will make some space free and speed up the
computer.

Nowadays, the use of ICT device can not be imagined without the internet
connection. Many cookies and temporary internet files are saved in the cash
memory of the internet browser when you surf the net. It slows down the
computer. If it is not possible to clean up the cash memory everyday, it must be
done in every few days' intervals. A piece of software can help you to get the
job done.

Using ICT device without anti-virus, anti-spyware and anti-malware is very
risky. It is an important maintenance activity that protects the users' device from
the attack of virus, malware and spyware, and they can safely use their devices.
Now many anti-virus, anti-malware, and anti-spyware software can be
downloaded free of cost from the internet and used to protect the computer. Even
these pieces of software can be updated from the internet.

The computer users can run disk clean ups and disk defragmentors to keep the
usual speed of the computer. These programmes are attached with the
operating system. These two pieces of software clean up the space of hardware
and arrange the files in such an order so that the speed of the computer is kept

up.
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Installation and Uninstallation of Software

We know that the ICT devices are operated with software. These pieces of
software have to be installed in the computer or in other devices. When we
purchase any ICT device, the seller asks us about the software that we require.
After installing the required pieces of software along with operating software, he
gives it to us. In this way, we can use ICT devices, for example, computer, tablet,
smartphone, etc., as we require.

The process of installing operating system software is complex, and expertise
is essential for this task. In addition to the operating system software, we need
different types of software. These pieces of software should be installed on the
basis of our needs.

Installation of any software requires special attention to the issues given below:

» Whether the hardware of your device supports the pieces of software to be
installed;

» Whether there is anything important in 'read me' file; if any, read it;

» Whether all other works are stopped during the installation; if not, the
installation process often gets hampered;

» Whether the anti-virus software is turned off, and

» Whether the administrator of the operating system has the permission or not;
(Almost all the devices have the permission except some particular ones).

Installation of software, except the operating system one, depends almost on the
operating system itself. However, the process of installation is almost the same.
We need the soft or the digital copy of the piece of software to install it. It can
be installed from CD, DVD, pendrive, or the Internet. In most of the cases, a
programme called ‘Auto Run’ is attached with the software. When you insert a
CD and DVD or connect a pendrive to the USB port, the ‘Auto run’ programme
becomes activated and the piece of software seeks permission to set up. Follow
the next steps after giving the permission and the piece of software will be
installed in your computer. After restarting the device, you will be able to use the
programme.
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The steps of installing a piece of software is shown below:
Double—<click the set up file of the piece of software. The following figare-1 is &
set up file. Double clicking on it will start the installation.
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(5 Wi rasa pmec 2 1) v —— = The steps can be followed for
Completing e VLG mecta dayer software installation:
2 1.3 Setup Wizard
VU ey bty 71T ek Bt e oot gt e roe e Mﬂt"'
Ehck Femds i chww B sapwed Fu]] § 'ﬂ]g I s ]] a "
R il e 213 of software suggested by your
teacher.

Installation of Software

Now you have learnt how to install a sofiware, Suppose that you do not need to
use the software anymore. What will you do then? Most of the users keep the
software in the hard disk. However, it occupies a space and creates problem to
run the ICT device smoothly. Therefore, it is wise to uninstall unnecessary
software.

How will we uningtall the software? The Operating System Software helps us to
get the task done. The nature of all kinds of Operating System Software is almost
same. However, it is easier to uninstall software from a device nm by the android
operating system, especially in the touch-screen smartphones. Select the
application from the settings and touch the particular software. A menu will be
viewed on the screen. Click the space where uningtall is written and the piece of
software will be uninstalled.

The following steps should be followed to uninstall a software from a computer
ot an ICT device rum by Microsoft Windows Operating System,

Click the start button and go to the Control Panel. Then double-click the *Add or
Remove” or point to uninstall a programme.
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®e § &

Click Uninstall of the programme

. el S that you want to remove, and
== i uninstallation will stert instantly, If

-y o =¥ the bulk of the file is large, it may

- ':.-.::‘.._,...“...;A.EJI = take longer. Usually the computer
S i SETET peeds to be restarted after the
uninstallation of software. Be careful

Actlvity before uninstalling any software; or

Following the steps, uninstall a else, uninstallation of a programme
piece of software suggested by mey make it impossible to run the

computer without its reinstallation,
Therefore, you must be careful.

Deletion of Software

We know that deleting means erasing something. In fact, by uninstalling a piece
of software, we delete it from our JCT device. What will we do with 'delete’
command then? A software once installed in the JCT device cannot be
uminstalled completely, unless it is deleted by following the recommended
proeess. Or else it creates problems. Some parts of the yninstalled programmes
are dumped in the Registry file of the operating system. However, it is possible
to delete any programme following the steps shown below. We should also be
carefil in doing the task.

The steps to be followed to delete:

At first, uninstall the piece of software as per the previous instructions, and
follow the next steps:
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Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.

1
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5. Save the file. It is very important. If any error is made, the system may be
repaired.
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6. Enter "Edit’ then.
7. Point to *Find’,
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8. Find out the name of the software to be deleted, for example, 'Audials’.
9. Click "Find Next’.
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10.  Belect in this way.
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11. Pressing the right button of the mouse, click the ‘Delete’ option.

12. Finally press ‘F3’ of the keyboard and delete | Gronp Activity
all the files having that name from the
Registry. In this way, the entire process of
deleting will be completed.

Comparing uninstallation
and deletion, present it.

Security of your Computer ;: Computer Virus and Antivirus

We have already learnt many things about the
computer vitus. In spite of that, we should learn
more, keeping in mind the security of our
computer, It harms the computer. Just as the virus
infects the human body, the computer virus infects
the computer. The full form of *“VIRUS" is *Vital
Information and Resources Under Siege’ which
indicates taking contrel of important information or
damaging something, It wag named by Professor Fred Cohen, a renowned researcher
of University of New Haven in 1983. A virus is a kind of software that attacks
data and information, and it has the power to increase its number. When a virus
enters the computer, it gradually increases in number and attacks the data stored
there, and finally makes the computer unusable infecting the entire device, For
example, a booting virus attacks the booting sector of the hard disk. Stone,
Vienns, CTH, Folder, Trojan horse, etc. are some most common viruses.
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If the ICT device is somehow infected with virus, it gradually increases in
number. A virus infected file may enter a virus free computer or ICT device
through a CD, pendrive or any other devices. The virus occupies the memory. It
stays there even after the computer is turned off. Installation of a virus-infected
programme or software also infects the ICT device in the same way. In this way,
a virus free computer or ICT device is infected with virus. The same thing
happens when a virus infected programme or a software is run in a computer.

In this way, the virus, which is occupying the memory, attacks other files and
programmes. Some viruses instantly infect all the existing files and
programmes, and some viruses infect only new programmes and files. Thus, the
virus deletes files and corrupts programmes, and causes a serious damage to the
machine. In this way, a virus free computer is gradually infected with a virus,
and it may spread to other computers through the CDs used in the infected
machine, hard disk and the Internet.

The symptoms given below indicate that the computer and ICT devices are
infected by a virus.

* Opening a file and progamme takes longer than the usual time;

» The memory has little space, leading to a slow performance of the
computer;

» Showing unexpected messages incompatible with the works while running
the computer;

 Installation of a programme takes longer than the usual time;
* The running files take more space;
» The machine shuts down during booting or working time;
» The names of the folders are replaced with cryptic names;
A virus can cause the following damages:
It can erase any save data or file;
* It can corrupt data;
» Abrupt and unexpected messages can be viewed on the computer;
» The display of the computer monitor can be corrupted;

» The entire system can be slowed down;
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What can we do to get rid of this situation? An anti-virus can relieve us from this
problem. An antivirus is the preventive of computer viruses. If the system is
infected with a virus, it should be wiped out. An antivirus utility is forced to
prevent virus infection. At first, these utilities find similarities with the samples
of viruses in the infected computers. The antivirus software by using its
experience repairs the original programme. An effective antivirus can wipe out
hundreds of viruses. When a new virus comes into being, update the antivirus to
enhance its power and effectiveness. As a result, it can destroy a new virus. Now,
there are a lot of antiviruses that can identify, prevent, and wipe out viruses.
Nowadays, the antivirus software remains attached with every Operating
System Software. Besides, the existing antiviruses destroy the viruses before the
attack or warn the users. Therefore, the anti-virus software developed nowadays
is more effective than the one used in the past. So, we should keep the antivirus
updated.

Now, we can download an antivirus software free of cost from the Internet to get
rid of virus-attack, and after installing it, we can ensure the security of the
devices. The names of some trustworthy antivirus are given below:

* AVG antivirus software (Downloading Website: www.avg.com)
* Avira antivirus software (Downloading Website:www.avira.com)
 Avast antivirus software (Downloading Website:www.avast.com)

We can follow the steps mentioned below to protect our ICT device from
viruses:

1. CDs, pendrives, memory cards etc. used in other computers should be
cleaned and made virus-free before they are used in your own computer;

2. The software used in other computers should be virus free before it is used in
your own computer;

3. Any file copied from other computers needs to be cleaned by the antivirus
software before you use it in your computer;

4. Be careful when you install a piece of software in your compute from the
Internet. If the downloaded software contain any virus, that may infect your
virus free computer;

5. Do not install any software used in other computers or devices;
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6. Always keep an updated antivirus software in your computer, so that prior
warning message can be received before a virus starts attacking the
computer. As a result, the computer may be disinfected right away following
the recommended process;

7. Data or files of everyday use should be saved in different disk or pendrive as
a back up, but the disk or pendrive must be virus free;

8. Be careful in exchanging emails. Don’t open any email from a doubtful
source. If you open it, make it virus free before opening;

9. Be very careful and check for viruses before using game files;
Password

Why do we lock the door when all the family members go on an outing? We do
it for the security of the house. Think a bit about the lock. Anybody can not open
the lock by using any key because different locks have different keys. A lock
cannot be opened with a different key. Thus, we ensure safety of our home and
other valuable things. Now, we see a kind of lock with digits. The lock is opened
by matching the digits. The digits work as the key. However, in an age of digital
technology, we have to think over the security of many other things. Perhaps you
have understood what we are talking of. We are talking of the security of our
data and information. In an age of ICT, we have to use a lock for the security of
our important data, information and the software. The name of this lock is
password.

Perhaps you have already learnt to create a password and use it. ICT is being
used everywhere now. Our country is not an exception. As its use has been
extended, the question of security becomes important. All of our personal
information, such as bank account, income tax, job, etc. have come under the
digital system. Besides, our ICT devices such as computer, laptop, tablet or
smartphone are operated with software. When we use the Internet, we can
communicate with the remote parts of the world. Similarly, anyone can
communicate and share information with us from anywhere. In this way, our
personal information can be transformed to others or our ICT device may
become susceptible to hacking or computer security vulnerabilities. We can
ensure security to prevent this situation. There is no alternative to secure our
information and protect the software of our device. If it is protected with a
password, nobody can steal our information or damage our device. But, we
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should remember one thing that if anybody can steal our password, he can steal
our information too. Even, he can destroy it. It is like opening the lock by using
a duplicate key. Therefore, we should be skilled in creating password. We should
not create any password that can easily be guessed by others or easily
forgotten.

As most of the users create passwords like 123456 or 654321 or abcdef, it
becomes easy to steal this type of password. Considering the significance of
data or information, it is important to create a unique password.

The security along with secrecy of a password ensures the security of data and
information saved in a server, computer or ICT device.

If your password is not unique,
1. Viruses may attack easily;

2. Hackers may take the opportunity of hacking the computer; so your money
deposited to your account may be transferred elsewhere and your important
information may be stolen by others;

3. Information saved in the ICT device may be destroyed.

How can you create a unique password? It is a creative work. Your creativity
can ensure the security and secrecy of your data and software. If some
processes are followed, we can easily do the job.

We should be careful of the following factors while creating a unique
password:

* Your name, names of your family members or any personal information
should not directly be used though it helps us to remember the password;

» Combination of digits, signs and capital and small letters will strengthen the
password. It becomes difficult for others to guess anything about it;

» Password should be long;

* You should not write the password or part of it either in the computer or
diary in order or remember it;

» Use a symbol of your own choice to remember the password; It can be your
favourite poem, short story, writer, scientific invention, or any historicl
event.
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If creativity is added to this, the password may be unique. Our password could
be as follows:

* MoriTeChaHina AmiSunDarVhubanE (Rabindranath Tagore)
* AmAr AchE wateR (Humayun Ahmed)

* 2BornoT2B tHatisThe? (To be or not to be, Activi
that is the question- From Shakespeare) vty

* 4Score&7yrsAGO (Four score and seven C:z:ita RASSWQCH AN
years ago- From the Gettysburg Address) P )

Changing password is an important task because a regular change of the
password ensures the confidentiality of the information stored on the device
and safety and security of the ICT device itself. However, password should be
something that can be remembered.

Stay Secured in the Web

The use of information and communication technology in our daily life is
gradually increasing. The use of the Internet along with mobile phone and
computer is increasing. When a computer or mobile device (phone, pad, tab,
etc.) stays connected to the internet, its security is at risk. The risk factors can be
reduced by being alert and taking special measures.

An Internet user surfs the website for many reasons. The process of
maintaining the security on the web is discussed below:

A. General Site: Many users take the general and cost-free services of yahoo,
hotmail, and gmail. The possibility of hacking in every site cannot be
ignored. If our account is hacked, important mails will be lost. Again, the act
of cheating or work like this can be operated by using the account, but the
liability will be on the account holder.

The precautions given below should be followed:

* An easy password should not be used. Many users use their own names and
easy orders of the keyboard (such as qwerty or asdfg or 123456789) as the
password of their email account. It is very unwise as everyone knows that for
email, the account is the user's or account holder's name. That is why
anybody can hack your account just giving it a few tries. So a complicated
order or combination for a password such as letters, digits, and signs (!@#,
etc.) should be used.
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* Passwords should be changed on a regular basis;

* Use 2-step verification where possible. For example, the security of your
gmail account can be strengthened by your mobile phone. The 2-step
verifiaction option of gmail can be used:

» Point to the account setting from the profile;
Get 2-step verification. Click the edit option;
Type the number of your mobile phone and click the 'send' button.

vV V V

A security code will be sent from gmail to your mobile phone. Click
"Verify' option typing the verification code;

» Turn on 2-step verification;

Now, if anybody seeks unauthorized access to your account, he requires the
mobile code, but even after knowing the code, he will fail to access the account
as the code can be used just once. So, your account will be secured. Similar
security measures can be adopted in yahoo! mail in the same way.

» If you send any email from a cyber cafe or a computer constantly used by
numerous people, log out of the account after using it.

Besides, if you follow some additional security measures, you will remain safe.
In some websites, different kinds of programmes are kept installed. If a cookie is
activated on the web browser, the information stored in the computers and
browsers of the users of these pieces of software will be sent to other
destination. So, it is necessary to be alert while using the website. Some
websites seek different personal information from the users. You should not
provide them with the information if there is no particular cause.

B. Social Site: Nowadays, many users keep their personal information on social
networking site. They share photographs too. So if the password of
Facebook account is stolen, the security of the personal information can be
at risk. The security measures suggested for the email site should be adopted
for these sites too. The following precautions should be taken for using the
social networking sites:

< Have information before developing a friendship with someone. Do not
be a friend of anybody who does not deserve it;

< If you make virtual friendship with people abroad, be absolutely sure
Forma-5, ICT-9-10
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about their identity. Check their profile and friend list to identify
common friends and acquaintances;

4 Do not share any personal photographs on Facebook;

4 Log off each time after using Facebook or email;

4 Sign out after browsing the Intemet in school or cyber cafe;

€@ Be cautious about using the laptop or computer of your friend or
acquaintance;

€ Don't click on any Facebook application sent by a stranget, if vou are not
absolutely sure of about its reliability,

C. Age Compatible Site: There are some websites only for the adults. These
gites are not suitable for you. This kind of websgite may put the safety and
security of your ICT device at risk and hinder the normal operation of your
ICT device. In order to protect the device, you must restrain yourself from
clicking on any suspicious photos, links, or advertisements on the website,
You should give an effort in developing your knowledge and skills in ICT
as well as your moral character,

Internet Addiction Disorder (IAD) -
connotations and it is usually used with
reference to drugs. It destroys life because it
is tough to come out of the web of drugs.
Perhaps you are confused thinking that how
an alarming and negative word ‘addiction’
can be asgociated with ICT and mentioned in
an ICT textbook. Some of you who have
computers may have crossed the limit while
playing computer games. A few of you did
not leave the computer even though you ™
should have for an important task. The users who have the internet access have
Facebook accounts too. When you post status on the Facebook, you cagerly wait
for a long time to see whether somebody gives a Like' to your status. You feel
pleasure when the number of your Facebook friends increases. Perhaps you may
have spent more time on Facebook than usual. You might have done better in the
examination if you had spent less time on this gocial network. You could have
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read some good books or played a bit more cutside in the playground or spent
mote time with your family members.

Perhaps you, who have been damaging your lives by wasting your time on
Facebook or by playing computer games more than you should understand the
cause of adding a negative word ‘addiction” with the positive words ‘Computer’
and the ‘Internet’. ‘Addiction’ means when someone, in spite of knowing itis a
freakish act, cannot resist the temptation of doing it. What is true for dmgs is true
for the computer and Internet too. As drugs are harmful for life, so are the
computer and the internet if they are nsed beyond the limit.

Addiction to Computer Games

An addiction to computer games beging from the
childhood, and it usually happens due to the
ignorance of parents. A computer is a tool and
different types of work can be done with it. As
many positive words are said of this technology,
parents think that what is done through a computer
is positive. Therefore, when they see their children
gitting at the computer for a long time, they do not
think of being alert. Computer games are a kind of
entertainment, and it has a different dimension. If you play computer games
merely as entertainment while staying within the limit, that can be a part of good
entertainment. However this does not happen most of the time. People across
age, children to adults, may be addicted to computer game. A Korean man died
while playing a computer game for 50 hours at a stretch. A Chinese couple gold
their child to pay for their computer games. These examples remind us that an
addiction to computer games is not unusual. If caution is not taken, one can
easily be addicted to computer game.

As addiction to computer games is new, extensive research hag not been done on
it, In fiture, it will provide us with absolute direction. Research has identified
the presence of a stimulating chemical in a gamer’s brain, addicted to computer
games. The shape of a brain is altered in those who use a computer 10 hours at a
stretch 6 days a week,

Therefore, we should keep in mind that computer games could be a good
entertainment, but it is very easy to get addicted to it, and the effect of it is
certainly damaging,
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Addiction to Social Networking Site

Man is a social being. They continued a social relationship all the time.
However, the nature of social communication nowadays is distinctly different
from the one in past. It means a different social networking based on the internet.
There are some social networking sites such as Facebook, twitter, instagram,
LinkedIn, Tiktok, Likee etc. through which people can communicate with their
circle. Once, these sites were only for the young people, but now people of all
ages use it. They use it not for communicating with others, but also for establishing
ideologies and legitimising their opinions. If it was within the periphery of
objectives, it would not have created any problems, but it is a matter of regret
that addiction to social networking sites has becomes a problem for the whole
world.

The psychiatrists have started doing research on this matter, and the findings
show that the success of the sites depends on how skillfully they can attract the
users. The main factor is how often users visit the site and how long they remain
on the site. The more the site is visited, the more successful the site is and
consequently, the more money the site will earn. Therefore, if the users are not
careful, there is every possibility of developing addiction to these sites.

Another interesting factor was identified by the psychiatrists. Individuals have
an inherent desire to impress and admire their own self. In psychology, this is
defined as 'narcissism'. The social networking sites instigate this inherent human
desire. A competitive attitude develops within everyone to make themselves
popular. The users upload minute information about themselves, and when
people watch and like it, they become happy. The entire system works like a
drug, and users waste their time for hours. In fact, a major waste of time
world-wide is caused by the immense popularity of social networking sites.

The Way out of Addiction

We have already learned in the previous section that a man can be addicted to
computer games and social networking sites just as he can be addicted to drugs.
Therefore, both drug and computer game or social networking site addicts
display a similar kind of signs and symptoms. It is wise to be careful than to try
to get rid of the addiction. There is an apprehension that the users who do not
know anything about the addiction may develop a tendency to it. Since you have
read about it in the textbook, you may remain more careful about it.
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People may become too preoccupied with it, as they do with other sources of
entertainment, However, playing computer games does not increase our
knmowledge on technology. You will just have the enjoyment of playing the
computer games, not any technological knowledge. You should be careful about
playing computer games, so that it may not affect the important works of your
daily life.

We hope that you will not be addicted to
computer games. Similiarly you will prevent
the people around you from being computer
game-addicts, Those who  become
game-addicts show some particular %
gymptoms. They always think sbout a |
particular game, and when they start playing
the game, they become excited, and they can
not do their daily jobs smoothly, They become I »
inattentive in their studies. When they are | %= o
forced to keep themselves aloof from playing AR ot
games, they feel discomfort. The point of worry is that the addiction may come
back even after they become free from this bad habit. The people, who somehow
have developed addiction to computer games and want to get rid of it, have to
acknowledge themselves the fact that they have developed an addiction. They
have to make a list of the important events of their life. They should convince
themselves about the place of computer game on the list. They have to make a
list of the problems of their life too, and they should identify the problems
caused by playing computer games. They should divide and allocate their time
to cover all the important aspects of life-study, homework, playground,
exira-curricular activities, spending time with the family, and vohmtary social
works. If they get spare time after doing all of these works, they will play
computer games, They should gradually keep themselves busy with creative
activities rather than computer games.

The users who have been addicted to social networking sites should proceed in
the same way to get rid of the addiction. They should try to convince themselves
that wasting time on these websites is a kind of addiction. When you have an
intention of watching something on social networking sites, you should ask
yourself whether you have really any purpose of watching it. If not, you have
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to control yourself. You should note down the duration of time you spend every
time on the sites. After summing up the time you spend on it in a day, week,
and month, you should come to a conclusion about the volume of work you
could have done during this time.

You have to reduce the number of unknown friends from your social networking
site to reduce your addiction. You have to convince yourself that you can surf the
sites after completing the important jobs. You have to develop the habit of
deactivating social networking sites when you have exams or other important
events. You will gradually reduce the addiction in this way, and finaly get rid of
it completely.

You should remember that every moment of your life is valuable, and it is
unwise to spend these moments for any addiction.

Piracy

The objective of copyright law is to provide the writers, artists, and others with
the exclusive right to their creative work. Usually it is expensive and difficult to
reprint any book by violating the copyright law, but now it is easy to make
‘copy’ or ‘facsimile’ using computer technology. It is not required to be an
expert for doing the job. Therefore additional measures are taken to protect the
copyright of computer software, graphics, and animation. When the legal right
is violated, they are deprived of their copyright. It is usually called ‘Piracy’ or
‘Software Piracy’.

The concerned entrepreneurs, writers or programmers can preserve the right to
their intellectual property within the purview of copyright law. That is why it is
illegal either to copy or create something new by editing the software without
the consent of the copyright holders. Therefore, the copy or the new creation has
no legal protection. Even though it is easy to pirate computer software, the
malpractice is not very frequent in the world. The renowned software companies
have formed an agency named ‘Business Software Alliance’ (BSA) to preserve
their copyright and to monitor piracy worldwide. The statement given by the
agency in 2011 shows that 7 out of 10 computer users are free from piracy. As
software piracy is an easy task, it is difficult to get the right statistics. Software
piracy is strictly prohibited in Bangladesh.
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The Urgency of Copyright Law

The copyright law ensures the right or ownership of the creators to his works for
a certain time. If the creation has any commercial value, the creator should get
it. As poets, litterateur, movie producers, software writers, web designers all
require money and web designers earn their living from creative work, they
invest labour, intellect, and money in it. They invest money for their labour and
merit of creative works. Therefore, they should have the right to get their money
back either by selling or exchanging the products. The legal right within the
purview of copyright law has given them the advantages. Artists or
programmers get disappointed if they fail to gain any financial benefits for their
creative or intellectual properties. The implementation of copyright law will
save the creative workers from being deprived.

Right to Information and Security

The law of 'Right to Information' is enacted and implemented in different
countries of the world to ensure the free flow of information and people's right
to have information. the 'Freedom of thought, conscience, speech' right to obtain
information has been assented as the fundamental right of the citizens in the
constitution of the People's Republic of Bangladesh. As all powers in the
Republic belong to the people, a law called 'Right to Information Act-2009' has
been enacted to ensure the right of having information. Every citizen has the
right to get information from any authority whenever it is sought under the act,
and the concerned authority is compelled to provide the information if asked. If
people's right to information is ensured through this act, the transperancy and
accountability of the government, autonomous, statutory organizations, and
NGOs funded by the government and foreign organisations will be increased,
corruption will be reduced, and good governance will be established. The right
to information has been ensured under the Act and directives have been given to
the organisations to preserve information.

The Act has ensured access to important information of the state. The
accessibility of government-held information is an important part of
government transparency and accountability to its citizens and good
governance. However, seeking and receiving information that may jeopardise
the security of the state is not permissible in the Act. For example, the Act
does not allow access to questions before the public examinations because the
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exam processes will become controversial. The secrecy of question papers is
secured through ‘Right to Information Act’. If technical, technological, or
scientific information is leaked out, the organisations stand to lose financially. In
this context, keeping the information secret is not the violation of the rule. The
most important factor is that any information that may pose a threat to the
security, unity and sovereignty of the state is not obligatory to reveal under this
Act.

Under section 7 of the Act, the authority is not obliged to provide certain
information, such as:

(i) Any information that poses threat to the security, integrity, and sovereignty
of Bangladesh, if disclosed;

(i) Any information in relation to the foreign policy, disclosure of which may
jeopardise the relationship with foreign countries, international
organisations, local bodies, and organisations;

(ii1) Any confidential information received from the foreign governments;

(iv) Any confidential sensitive business information, the disclosure of which
may violate the intellectual property right of the third-party and any
information in relation to Copy Right and Intellectual Property Right;

a. any advance information of tax, revenues, VAT, excise duty, budget, or
tax rate changes;

b. any advance information on changes in currency exchange rate or tax
rate;

c. any advance information in relation to administration and management
of banks and other commercial organisations;

(v) Any information, the disclosure of which may hinder implementation of
law or increase the rate of crime;

(vi) Any information, the disclosure of which may hamper the safety and
security of population and may impede a due judicial process;

(vii) Any information, the disclosure of which may disturb the privacy of
individual personal life;

(viii) Any information, the disclosure of which may endanger an individual life
and physical safety;

(ix) Any classified information given to law enforcement agencies;
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However, it has been laid down in section — & (9) of the act, that, any information
should not be refused by the authority only for the reason that, it is related with
the information the disclosure of which iz not compulsory. Rather the
information should be separated reasonably and delivered to the applicant,

General Troubleshooting

It is uynusual that electronic devices have not gone out of order or not created
troubles during using. Some problems are very usual, and some are unusual and
complicated. Usual problems can be fixed by the users, but they have to teke the
help of experienced people for complicated problems. Computers or ICT
devices are not exceptions. Those who use electronic devices have noticed that
an operating marmal is given with every device. The manual contains a section
on the last two or three pages, entitled, "trouble shooting'.

Troubleshooting is the process of finding out the source of troubles. Usually
some questions are given with solutions. The users, according to the nature of
problems, solve them following the solutions.

In fact, trouble-shooting is a gystematic process of identifying the source of
problem in the ICT devices in order to solve it. In the manual, usually some
possible problems and solutions in relation to the ICT device are mentioned.
The users, following the basic trouble-shooting steps given in the manual, can
usually resolve the problem in most of the cases. Usually the word
‘Troubleshooting’ is wused for hardware related problems. Some
troubleshootings are discussed below:

Forma-6, ICT-8-10
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Sl nos. Problems General Solutions
1. Computer is not Check the main power cable whether the
) connection is loose or not.
starting up. Check whether there is power on the main power-board.
If there is no power on the main power-board,
change the main power supply unit.
Take the device to the local service centre and
consult an expert.
2 Nothing is Turn off the system and unplug the power cable
" | viewed on the from tha main system.
monitor Remove the RAM from the slots.
though.the Clean up the connectors of the RAM rubbing them
syste.m IS with an eraser.
running.
unning Clean up the slot of the RAM with a hard brush.
Turn on the computer without installing the RAM,
and notice whether you get any beep sound.
If you get any beep sound, turn off the computer,
and again turn on after installing the RAM.
If you get any beep sound, you have to understand
that the RAM is faulty.
Install a new RAM if there is no display yet.
Install the RAM, and check again. Faulty RAM is the
reason for at least half of the display problems.
3. | The system Open the Casing.
becomes very Remove the CPU or processor fan from the
heated, and motherboard, but don't remove the processor.
abruptly shuts Perhaps the heat sink is filled with dust that creates
down. obstruction on the free flow of air. As a result, CPU

can not be cooled.

Clean up the heat sink and fan, and install again.
Now, after closing the cabinet, turn on the computer
again.

If the problem is not solved, take the computerto a
service centre, and talk to an experienced
mechanic.
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Slnos.| Problems General Solutions
4. The computer Check the mother board carefully and find out if
shuts shown on there is any leaking or faulty capacitor has got
its own at every loosened. Tighten the capacitor and the problem will
few minutes, be resolved.
EUt:t: not Notice very carefully as the computer is running
cated. whether any IC or any other component producing
extra heat. Be cautious. Let not the board be shorted.
If it happens, go to the nearest service centre.
5. The device Check whether there is any virus in the hard disk by
freezes running an upgraded anti-virus.
Whlle_ h Taking the back up of important data from the disk,
rur.mlngt € format 'C' drive, and reinstall Windows. It should
Windows.
be done by an expert.
6. Display freezes |1. 1st Step: Turning off the power button and

when the
power button is
turned on.

opening the caching, carefully remove the
data-cables and power-cables connected to hard
disk, CD-ROM, and DVD, and after reconnecting
the cables, restart the computer.

2nd Step: Check RAM, processor, power supply
connection separately whether they are faulty or
loosely connected.

3rd Step: Check the motherboard using the
processor, RAM Hard disk and other related
equipments from an active computer. If it is not
active, change the motherboard. Get the job done
by an expert hand or taking the computer to a
service centre.

Note: Sometimes this problem persists when the

keyboard and the mouseport of the motherboard
are loosely connected. Set the connection

properly.
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SInos.| Problems General Solutions

7. | The computer If the cooling fan set over the CPU does not move
repeatedly or cool the system properly, this promlem occurs.
freezes, and In that case, switch off the power, and opening the
reboots cooling fan, check it out. If the fan is faulty, replace
automatically. it. Besides, check the fan behind the CPU while the

computer is running.

The problem persists if the computer has any virus.
Clean up every drive of the hard disk by running
an updated anti-virus. Besides, it happens due to
the installation of new hardware or programme. In
that case, uninstall the programme and run the
computer.

8. Slgtcttlng an If you get electric shock by touching the metal part of
shock when the computer, it is certain that the computer has
you touch the not earthed. Calling a skilled electrician, get the
{Egtgcl,r%agagn computer properly earthed.

9. | The date of the If the CMOS (Complementary metal-oxide
ccgrr:;?tllj;%rislSIQ)?gd semiconductor) battery of the motherboard loses
all the time or if power, this problem occurs. In that case, set a new
?ﬁg I‘S)I%ts"i);‘ of CMOS battery on the motherboard.
changed, itis
not properly
saved.

10. | Showing the Switching off the power, open the caching, and

message '‘Boot
Disk failure' or
'Hard disk not

found.

check the data cable connected to motherboard and
hard disk drive, and check the connecting point of
the power cable from power supply unit to hard
disk and properly connect it.

Set the jumper properly following the jumper
setting diagram on the back of the hard disk.

. Entering the BIOS, check whether the hard disk is

detected from the options of the BIOS either
manually or automatically. If the problem is not
resolved, connect your hard disk to a sound
computer and check whether it works or not. If the
problem persists, buy a new hard disk and install
the programmes you require. Get the job done by
an expert.
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Sl nos.

Problems

General Solutions

11.

Showing
messages like
'Out of

. Usually these messages are shown when you install

excess programmes, and work keeping a lot of
programmes open.

memory' or 2. If the computer does not have sufficient memory
'Not enough for installing excess programmes, this problem
Memory' occurs. Additinal RAM can be installed in the
motherboard to resolve the problems.
12. | The keyboard is 1. Shut down the computer, and check whether the
not working. keyboard is properly connected to the port.

2. If it is not properly connected or the connection is
found loose, refix it and turn on the computer
again.

3. Clean up the virus by running an anti-virus software.

4. If the problem is not fixed yet, install a new
keyboard.

13. | The mouse is 1. Check the connecting-cable of the mouse to the
not detecting computer.
anything. 2. Change the port to see whether it works.

3. Connecting a new mouse to the port, check it
again.

4. Entering the BIOS check whether the mouse is
disabled. If so, enable it, and come out of the BIOS.

5. If the problem persists, connect a new mouse to
the computer. The problem will be resolved.

14. | No power is 1. Be sure whether the power button is turned on.
viewedonthe |5 (heck the AC power cord connected properly to
monitor.

the power outlet behind the monitor.
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Sl nos. Problems General Solutions

15. | The power of 1. Check the video cable whether it is properly

the monitor is connected to the computer or not. If the other
viewed on, but point of the video cable is not permanently
there is no connected to the monitor, fix it firm.
displayonthe | 5 Adjust the Brightness and Contrast.

monitor.

16. | The printer is 1. Check the power cable connected to the printer.
not givingany | 2. Check whether the button of the printer is turned on.

printing output. | 3. Check if the data cable of the printer connected
properly to the computer.

4. Opening the cover of the printer, find out whether
any paper is jammed inside the machine.

5. Check whether the cartridge contains any ink.
Remove the cartridge, and fix again after shaking
it well.

6. If red or yellow blinking light is shown, press the
reset button of the printer.

7. If the problem is not resolved, install the driver
sofware supplied with the printer.

8. Consultan experienced hardware expert.

Group Activity

Discuss what other problems a computer may have besides the ones
listed above. Identify some solutions to these problems.

Exercise

1. What happens when you have many temporary files?
A. Computer runs slow. B. Computer runs fast.
C. Antivirus does not work. D. Internet access is denied.

2. Which programme runs fast while installing a piece of Software from CD,
DVD or pendrive?
A. Setup B. Autorun
C. Read me D. Restart
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3. Which one is the resource of the modern world?
A. Information B. Data
C. Computer D. Internet

4. Installation of software requires attention on whether —
1. it supports the hardware or not.
ii. the antivirus software is closed or not.
iii. it has the permission of the administrator or not.
Which one is correct?
A i&ii B. i&iii
C. ii &iii D. i,ii & iii
Read the section below, and answer the question numbers 5 & 6:

Mr. Ekram has been noticing for a few days that his computer restarts after being
shut down at irregular intervals. He remembers that it started happening after he
copied a song from the pendrive of his friend a few days ago.

5. The error responsible for the computer might be?
A. Operating System Software  B. Virus Software
C. Utility Software D. Antivirus Software

6. For this reason, the computer of Mr. Ekram —
1. may show an unexpected message.
ii. may increase the size of files.
iii. may show that it has insufficient memory.
Which one is correct?
A i&ii B. i&iii
C. i &iii D. i,ii &iii
7. One of your friends play computer games frequently. What negative impact
may this have on him? Discuss.

8. 'It is very important to know about the troubleshooting of computer—
Explain the statement with your arguments.
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After completing this chapter, we will be able to—
» explain the concept of digital content;
» explain the significance of the Internet in education;
» identify the fields of using Internet in an academic curriculum;
» explain the importance of ICT in career development;
» make a pregentation on a related topic with the help of Internet.
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Digital Content

If any content is preserved, expressed or exchanged as digital data, that is digital
content. However, it can be preserved either in a digital or in an analogue
system. Digital contents can be exchanged either as files of the computer or of
the digital system. Written information, images, sounds or videos anything could
be digital contents.

Types of Digital Content

Any information, image, sound or everything expressed through a digital media
is digital content though it can be divided into four major categories:

» Text or written content;
» Image;

* Sound or audio and

* Video and animation.

Text or written content: The written content is still voluminous in digital
media. It includes all kinds of written information, such as essays, blogposts,
list of commodities and citizen's charter, prices of commodities, e-paper,
reports, etc.

Image: All kinds of pictures, photographs, sketches, and computer images such
as illustrations, cartoons, info-graphics, or animated pictures are the contents of
this sort.

Sound or audio: All the contents of sound or audio are included in this
content. Any kind of audio file along with the broadcast on the Internet and
webinar are audio content.

Video and animation: Any kind of video and animation is its content. The
volume of video content is increasing day by day, as nowadays mobile phones
also have the ability to record video. Similarly, the volume of video content in
the Internet is gradually increasing for the video sharing site like youtube.
Besides, direct airplay of some events is very frequent on the Internet. It is
called '"Video Streaming' which is also regarded as a video content.

E-book

E-book or electronic book is the electronic format of the printed book. As it is
published through an electronic medium, sound, animation, etc. can easily be
added to it. These books can only be read either by using computer or e-book
reader. Kindle of Amazon.com is the most popular of all e-book readers.

Forma-7,I1CT-9-10
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Benefits of Using E-book

1.
2.

Information may be accessed instantly by downloading e-books.

E-books do not require any library or specific space for storage. They can
easily be saved and stored on a computer or in a reading device.

E-books are easily transferrable.
It is easy to find out information in e-books.

. As e-books can be purchased through Internet, they do not incur any

shipping or packaging costs.
E-books are easy to distribute and sell.

E-books can be printed out according to individual demand, and hence, they
are financially more viable.

Nowadays, different kinds of e-books can be found. Different publication
requires different e-book format. Usually e-books are divided into the following
five categories:

Exact copy of a printed version: These books are like their printed versions.
They are published in the pdf (portable document format) format. The
complete texts or parts are available on the internet.

E-books that are only readable on the internet: These books are usually
published in the HTML. This is called the website of books.

E-books like printed version with some additional facilities: In these books,
the readers have the facilities to comment and to know word meaning. Most
of the books are published in (EPUB) format. These books are possible to
read by using a special device, for example, ibooks and kindle reader, but
the kindle and ibook reader have their own compatible format.

Smart e-book: Audio, video, animation, etc. are included in these books
along with the written part. These books are called smart-e-books. Its content
is enriched with interactive multimedia features. For example, there are
quizzes, spaces to answer the quizzes, and options to check the answers. 3D
images are added to these e-books. However, some e-books are formatted in
such a way that they can be accessed with a specific electronic device and
hardware. For example, ibooks created by Apple computers can only be read
with an ipad or mac computer.

Apps of e-book: The e-book itself is published as an app on the computer or
on the mobile phone. The e-book, like the printed version, is published under
the Copyright Act.
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The Internet in Education
We discussed ‘e-learning’ in a previous chapter where we showed how educa-
tion and training can be imparted by using radio, television, CD-ROM, personal
network, and the Internet. In this chapter, we will have discussions especially on
the role of Internet in education.

You are very much familiar with the word ‘Internet’. Many people are using it.
This technology has brought about a significant change to the world, and some
infrastructural facilities and financial solvency are required to use it. Either a
desktop or a laptop computer is necessary to use the Internet. It is expensive and
cannot be afforded by the majority of the population. Nowadays mobile phone
technology has been upgraded and the ‘Smartphone’, which can provide the
internet facilities, is within the reach of most people. However, the smart phone
is not always an effective tool for educational purposes. The screen of the mobile
phone is so small that its use is confined within the limit of viewing and
exchanging information. A recent invention, the tablet-an electronic device
typically smaller than a laptop, but larger than a smartphone, can be used in
education easily. Many companies are designing applications suitable for tablet
to use in education.

We can not avail the internet facilities just by having a desktop, laptop, tablet or
smartphone suitable for internet-use. An internet connection is required for that,
but it is not equally available in all the places of the country. The speed is not the
same. Sometimes a slow-speed internet makes its use meaningless. On top of it,
fast and high speed internet service cannot be afforded by the general people of
our country. Therfore, the students should get the internet connection at low cost
to use it in education.

Our students' access to a laptop or tablet and high speed internet will not ensure
the use of ICT for their education. The main question is what they will use in the
internet. Is there any content suitable for them? In fact, there is not much content
available on the Internet in the Bangla language. Initiatives have been taken by
the Government, organisations, and individuals for developing content in
Bangla. We expect to get it very soon in the internet.

Many educational contents are now available on the internet. If a student cannot
understand anything while studying, he/she is sure to get any solution by giving
a search on the internet. If any student wants to learn anything, he/she will find
it on the internet. The technologists of our country have successfully made
effective search engines.
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There are useful websites for mathematics on the Internet in which the answers
of any mathematical problem can be found. There are websites for practical of
scientific experimentations. Expert groups are formed by enthusiastic people,
and when problems are placed before them, they solve it. There are also some
useful sites available on the Internet for teaching Bangla.

A vast world of knowledge is on the Internet. Now we know that internet plays
a vital role in any disastrous situation. Use of internet in education will be
significant in near future.

The Internet and My Academic Subjects

Perhaps you hear that a teacher is like the flame of a light, and in darkness, they
kindle the light of knowledge that illuminates everything and the students see
the ways in the light. In other words, the best teachers in the world cannot teach
anything, but they can only help the learners to learn everything themselves.

Similarly, access to good content on the Internet will not always ensure great
learning experiences and sound education for students. The Internet only
provides them with the opportunity to open a new world of knowledge. It
depends on the students themselves how much they learn from it. You must have
come across students who waste time on the Internet, either by playing computer
games or by being engaged in social communication sites. By contrast, some
students learn computer programming availing themselves of the opportunity.

You have certainly noticed that all of Activity
your textbooks are available on the
Internet. In the beginning of the year,
you get the textbooks, but if any book is
either lost or damaged for some reasons,
you can download it.

How can the blind people be
benefited by using digital content?
Write a report within 1000 words
by taking help from the Internet.

You will be pleased to know that some enthusiastic educationalists of our
country have started making oral versions of the textbooks in soft copies, so
that blind students can be benefitted from these oral versions.

NCTB publishes all the textbooks and sends it to you free of cost. Besides,
many supporting books are also written (we are not talking of the guide books
that actually do not contribute to learning). Those who write these textbooks
upload them on the Internet. Students can download these books directly from
the internet without purchasing them from the market. Many writers of the world
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have arranged their books to be available on the internet. If you surf the internet,
you will get your favourite books free of cost. However, you should be cautious
about downloading any book preserved online, keeping in consideration the
Copyright Laws.

We know that our students are not satisfied with what they get in the textbooks.
Therefore, they open science, mathematics or literary clubs. Once, students
could participate in the activities of the clubs physically, but now they have
access to the clubs virtually open on the Internet. Now students of the whole
world can participate in the activities of the clubs and increase their academic
competence. Now-a-days olympiad on different subjects are being arranged in
our country. You are increasing the fame of our country by participating in the

olympiad.

My Career and ICT
In 21% century, it will be impossible to think of a day without ICT. Because of

the multifarious use of ICT, it will become an important factor in appointing
employees or establishing new business firms.

You should develop expertise in ICT for your own career. It will be simply
impossible to get any job without having the preliminary skills in office
software, internet, e-mail, social networking system, etc. The demand of
programming, designing websites, and expertise in specialized job like the
security of computer, etc. will increased. Therefore, the prospect of ICT as a
career is undoubtedly bright. You should give effort in enhancing the skills in
ICT henceforth. ICT is a great field for developing career in the world.
Computer is the main requisite of ICT. The potentiality of ICT in providing new
avenues for numerous computer-related jobs is beyond imagination. Computer
science, computer engineering, office automation system design, artificial
intelligence, robotic engineering, mobile communication, data communication-
these are only a few of the thousand possible sectors that lead to a successful
career in ICT.

The wide scope of programming is extending in Bangladesh like in other
countries. The demand of programming is high right now. Everything is being
computerized. Programmes are made by software. Different applications of the
smartphone are created by programming. The technology advances so quickly
that one day the television, refrigerator, air-condition, etc. of home would be
controlled from the office. The mobile devices can detect the symptoms of
diseases. The size of electronic devices is getting smaller, but their efficiency
and performance are increasing. It will continue to do so. The control of



54 Information and Communication Technology

everything from kitchen to satellites will be within the reach of human beings.
All will be controlled through computer programming.

The efficient programmers of our country are now working for the world
famous companies like Google, Microsoft, Intel, Facebook, etc. on freelancing
sites. Besides, skilled programmers can open software farms if they want.

Programming as a profession has a special importance. There are wide scopes to
prove one's efficiency through participating in different online programming
contests. Thus these contests have created opportunities for university graduates
from Bangladesh to work in the universities of Bangladesh, opportunities have
been availed such as Microsoft, Google, and Facebook. Every year, many of our
students, by using their talents, obtain strong positions in these renowned
companies. In most of the cases, they do not need to apply for the job. These
companies find skilled programmers from different countries.

There are other job facilities especially available in the ICT sector. It provides
the scope of doing office from home. The renowned companies in developed
countries, because of unavailability of skilled workers in their own countries,
offer job opportunities to the skilled workers in developing countries. The
workers of our country are of global standard. Now the programmers and other
ICT professionals of our country are working through the Internet for the
renowned companies of America, Canada, Britain, etc.

Patience is required for working freelance, and proficiency in the English
language is necessary for communication. Besides, ICT provides opportunities
for working in computer network. The companies using servers of their own
need experts for developing computer network and maintenance. That is why it
has a very good prospect in job market. The demand of ICT increases day by
day in this age of information and communication technology.

Some software companies have already been established in Bangladesh. They
are exporting their software and mobile apps to other countries of the world. It
is an honour for us. The younger generation is entering the profession. This
sector needs more skilled workers in future. Therefore, the prospect of ICT as a
career is undoubtedly bright. You should try to enhance your skill in ICT
considering all these factors.
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Exercise

1. Which one is essential to excess a website?
A. Desktop PC B. Tablet PC
C. Smartphone D. The Internet Connection

2. Which one is the constituent part of Information and Communication
Technology?

A. Computer B. Television
C. The Internet D. Smartphone
3. Digital contents are —
i. e-books, Blogposts and e-articles
ii. info graphics and Animated Film
iii. audio and Video Streaming
Which one is correct?
A i&ii B. i&iiii
C. ii &iii D. i, ii & iii
Read the section below, and answer the questions 4 & 5:

The father of Rini and Rony purchased a Tablet PC for them. Rini and Rony
read in class IX and X respectively.

4. The best use of the Tablet PC for Rimi and Rony will be for -
A. Playing games B. Listening to music
C. Calculation D. Study

5. For the highest use of the Tablet PC, Rimi and Rony will need-
1. a faster internet connection
ii. cheaper internet service
iii. better skills in the English language.

Which one is correct?
A i&ii B. i&iii
C. il &iii D. i,ii &iii
6. How can ICT be helpful for building up our career? Explain.

7. 'Now it is impossible to study without the help of the Internet,’ explain with
your arguments.
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After completing this chapter, we will be able to-
explain the important aspects of a word processor,
describe the techmique of using a word processor;
explain the important aspects of a spreadsheet;
idnetify the fields of using a spreadsheet;

describe the technique of using a spreadsheet;

edit by using a word processor;

keep the details of account by using a spreadsheet.
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My Writing on Word Processor

Writing is a medium of expression. We have to write for different needs. It might
be a piece of literature like poem, short story, novel, diary, etc. In our daily life,
we have to maintain different kinds of accounts, both big and small, like
expenditures of daily necessities, house rent and result sheet of examination, etc.
Once, writing and keeping these accounts were very difficult, but now we have
a lot of softwares for doing these works due to the development of information
and communication technology. These softwares are called office softwares.
These softwares can be used in our desktop, laptop and smartphone. We have
word processors for writing and spreadsheet analysis software. You have got a
preliminary idea about these in the previous class. Now you will get advanced
ideas regarding these topics.

Writing of anything means bringing the imaginary world to reality in words. We
know that human beings started the art of writing to communicate their thoughts
and their ideas and convey their imagination to others. Now ICT is being used in
this work, and the importance of word processing is immense in this regard.
Something written is required for receiving and presenting information on
television, mobile phone or computer. Now all types of writing are done by the
help of the word processor. The word processor provides lots of facilities in
terms of writing.

* Any correction in writing can be done immediately. Because of the varieties
of editing options, any piece of writing can be presented aesthetically.

» A piece of writing can be presented in different ways, for example, by
enlarging or shortening the font-size, colouring, making boxes, etc.

« There are facilities of inserting new paragraphs, deleting parts or rearranging
the whole writing without composing the piece of writing from the
beginning.

* A document can be more attractive by inserting photographs, graphs, tables,
charts, etc.

» A document can be saved and used again at any time. The same work needs
not be done repeatedly.

» Any part of a document can be copied to another one, if necessary.

Forma-8, ICT-9-10
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» It is possible on work with several documents simultaneously.

» By using find-replace command, a8 word in a8 big document can be found
and replaced quickly.

* When a document is needed for a repeated use, it can be saved as template to
avoid the wastage of time. For example, if it is required to prepare a
lab-report every week, it can be saved as a template.

» In a large document, such as, a research paper, tables, references, images,
bibliography, etc. can be inserted and edited within a very short time.

» Spelling errors can be comrected easily by the spell-checker. Automatic
correction of spelling is also possible in the word processor with its built-in
programmes.

« It is possible to print a document as many times as required by saving it.

* A document can be sent to any destination through the medium of
electronic communication.

» Files prepared in the word processor can be preserved easily.

* File management, an indispensable part of the modern office management,
has become easier for the word processor.

Besides, the word processing software provides more facilities. The number of

users are gradually increasing day by day due to its usefulness.

In the previous class, you leamt the process of creating and opening a new
document in the word processor. Now we will learn some new techniques for
which you need to use your knowledge and skills you have developed earlier.

Office Buttons and Its Options M

A new window will open after running word 2007, This 3 icon at the left
comer above this window is the office button. The options you will find by
clicking the button are shown in the following image:
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The following options are most important:

New: This button is to be clicked for opening a new document.,
Open: It is to be clicked to open a document saved previously.
Save: To save a document, this button is to be clicked.

Save as: Thig button is to be clicked to save a document in several different
names keeping the original one.

Close: This button is to be ¢licked to close an opened document.

Formatting Text: Selecting Font Style and Colour

You have already leamnt how to write using a word processor. What will be the
impression if an organiged piece of writing is presented in a colourful way?
Certainly, it will look good. This task is called 'Formatting Text.'

Font Size

[—ra 1_ 14 A~ 7| l '

B, = ==

‘ Paste B I U - ahe x, X' Al"”'y L.
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There are letters of different styles in 2 word processor. These are called "Font’.
In formatting & text, the selection of font comes first. This selection is done from
the name of the font of font group from the drop-down box on the home-menu
Pick the font that you like out of numercus fonts. Sometimes, it is required to use
fonts of different styles either to highlight or specify words or phrases. In that
case, select the requisite section of writing, select the font in the similar way.
Click the number from the dropdown box at the right side of the font box to
determine the font size. You can select the font colour as you like, Clicking on
the icon of the dropdown box of font group, the colour can be selected. There are
more facilities of fonts in the font group of home tab.

Activity

Composing a paragraph from your textbook in the word processor, format it by
using different font style, size and colour and finally save the document, giving a
name.

Formatting Text: Bullets, Numbering and Line Spacing

Owur Fruits Onr Bivers

» Mango 1. The Padma

+ Rlackberry 2. The Meghna
< 3. The Jamuna

* Lateh 4. The Surma

* Jackfruit 5. The Bhalrab

* Coconut 6. TheTista

Sometimes we make lists of different things, and use either signs, or letters or
numbers to maintain serials. This is called bullets and numbering in the word
Processor. -

There is an icon command for bullets and = 2] == = al) 1)
numh&tl:;g in the paragraph group of the = 2 w3 &
ragraph s
HESS = ','.—rp? ?.;{_“11] paller |° Suber] ¢ !
MLE 1 1= R
Patagragh - Line Spacing : This tool is used to determine the
¥ space between two lines,
l Line Space l
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Activity
Write down the names of some of vour favourite cricket players by using
bullets and numbering.

Formatting Text : Table and Different Illustration

The insert tab of ribbon is used to insert a table, image, clip art, different
shapes, chart text box, word art, ete. inte a document.

_,-"- rhn'hrup—mmn—mi--n—ul_-w-mhﬂ
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Comal Wikiih  Peye [FT = TS T T utd.lq [ TS Hu—i Criad e iewALE nu-n-- Fested P Bt [piil Wl [ang
Fags Feoge  Beviid ol - Flaiidans = Basm=  Pati~ E Cit =
Fugen 1l Bl ] [ BT (]

(Sf] wwiees s Click the (1) Insert tab o the ||
|| = kD ’;: .;:’ ; ribbon of word 2007 to add a
table, (2) Then click table

000000000 end elick (3) Insert table.
e et You will get a dialogue box
BiSin m/|m where you have to select the
000000000 aumber of columns  and
IO

Z1 - jnbest Tabia | Tows,

s
=

|

i

E

E

3

‘[ Activity
Make a group of 10 students, and ananﬁe the name,

fag'll:r's name, age and roll number of each student in a
@

By inserting pictures, document

can be presented in attractive

way. For exa.mple, you are Insert Page Layout Referentes Maillngs
watching & lot of pictures —

along with writings n tis SRR RESAENlr s,
text. You have to click the page  7Table  Pidure Clip Shapes SmartA Chart
insert tab of the ribbon of % ° S
word 2007. Then click the e B
picture icon of the illustration group. A dialogue box will come. Select a space
for the picture and the picture will be inserted into the document. Besides,
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facilities of inserting clipart, shapes, smart art, chart, etc. are provided in the
1llustration group.

Ingert 1:'|1a do with the
icture i t
hﬂlpoF]rFt:ur in cument prepared by you
Insert Word Art
b 4=y RQ o e You can insert fonts of differemt
E:" o [ — “8* gtyles from the insert tab, and to
IMWWHMM._-. choose your style, you have to click
Sordie! Worddn Wordhrt mardsrt W word art of insert tab's text group. A
N e WO dialogue box will come, and you
. . will get the desired style of your
m m u T L -
- text after selecting the font,
Setting up Margin

T 1t is required to click the page lay

Tnsert | Page Layout | References Mailings oevi OUL tBb 'Df the ﬂ-bhn to detﬂm.lne

| _d B [—ﬂ;I 2| Hlees- the margins of the text, Then
=t =] Fracy — ! i mumees - clicking the margin icon, desired
Marvgm:. Dﬂt-n;tanun SIfE Cl}ll:ml':s B2~ Hyphenation - mmg_jn iS 1o h set. Diﬁ'ermt Upﬁms

Fage Setup. “ of margins will be on the screen

when you click on the margin icon. You can select the margin from the options
or use your own margin clicking the custom margin,

Activity : 1
Render the name of your school in different styles of word art.
Activity : 2

Set the margln after preparing a document,

Line Spacing of Paragraph
Click the page lay out tab to

select the space between lines ndent ) i'i':':h"ﬁ ‘
of a document. It is needed to Flet 0 - | v= Before: Opt -
select the points before and == Roht 0° |12 atter 10pt  :
after lines in spacing of the Paragraph E
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paragraph group. The command can be given after composing the document. In
that case, first, the section of the document in which line spacing will be
inserted should be selected. Then it can be determined as per the instructions
given above.

Activity
Compose a part from either from your Bengali or English textbook and
determine the line spacing.

Insert Page Number

a2 4

Text Quick Words

Inserting page number on every page is an
important task while composing any document. | 8o~ Pars>
Clicking the page number of the header and footer =mns 8 Tovormee

& | Bottom of Page

| Header Footer

v w» v w [

group in the insert tab on the ribbon, the right [ L (i

option can be chosen. You can insert page number g Current Position

either on the top or at the bottom of the page. B e o inier
Activity

Save a document composed by you giving page number.

Spreadsheet and My Accounts
Analysis of Spreadsheet

You are familiar with the use of spreadsheet in class VIII. Can you remember the
specialities of this programme? Let us have a look again on what the specialities
of spreadsheet analysis are.

Specialities of Spreadsheet Analysis:

= It is possible to work with statistics and letter-based data;

= It is advantageous for any kind of accounts;

— Classification is casier for the rows and columns;

= It is possible to work with voluminous data by using formulae;



B4 Information and Communication Technology

g_:: "E] ' Best] - Wbt sl g =X
i e e e K R BT A

Lt PPt S Tt b b 2 Ak L b B T 2 Fhmmsndbionira [Ravaslaaliisg 5 - Pl

: & L] £ i [ ] (i} ! ! E

: —

.-'I"..- N $houtt, Sl RIS ) .| _ EI'J:

Yoy el B |
= Analysis of data can easily be done by using different functions

methodically;

= Data can be presented with grapha, charts, etc.

Different Uses of Spreadsheet

A spreadsheet is an interactive computer application software used for
organisation, analysis and storage of data in tabular forms.
Different uses of spreadsheet are given below:

1. analysing exam resulis in the educetion sector;
maintaining income and expenditure accounts;
preparing budgets;

maintaining records of employee salaries;

making reservations for services, such as airlines;
calculating and analysing income tax;

counting votes in elections;

analysing and evaluating performances of players.
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Technique of Using Spreadsheet

You have already got some fundamental concepts of spreadsheet, You will get
advanced ideas in this book.

Multiplying

Put the formula in the result cell for multiplying in a spreadsheet. Formula
always start with "=" equal to. Multiplying process is of two kinds:

! Formula |
D]-_ _- ., ! =83 . e

A . c ' ®
Monthly Shopping Expenditure
Prodoct MName  Price (tk)  Quantity (Kgh Eapenditure

Rice 44 a0

1. Usually press the enter
button, after putting the
formula into the result cell.

P PR

2. Press enter button writing spreadsheet finction= PRODUCT in the result
cell and giving the cell range.

f

D3 - J= | =PRODUCT(B3:C3)
| 4 A L B | c | D
a: Monthly Shopping Expenditure
_2 | Product Name Price (tk)  Quantity (Kg) Expenditure
3| Rice 44 40 1760

4 |

The facility of multiplying by using function is that the result of multiplication
of numerous cells can be done by range, if necessary. The process of
multiplying 3 cells is shown in the picture below:

D3 ~ (s f= | =PRODUCT(A3:C3)
A |8 | c l D o
Volume of Cube

=
pr=t

- Yenath Width Heigh Volume
3 | 40 15 14 8400
=
Activity

Opening a file of spreadsheet, multiply some imaginary data.
Forma-9, ICT- 9-10
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Method of Dividing

Dividing can also been done on the spreadsheet by a formula. You have to
write =A1/B1’ in the result cell to divide Al by B1. Here the sign / is used as
the sign of division.

a3 v =A3/83
ﬁ A | 8 l—ag_l, Try to find out the
1 April 2014 result by using the
— formula.
2 Monthly Income Nuiriber of Days Duily Income
I s
Calculation of Percentage

How much is 15% of Tk. 4007 What is the selling price at profit 16% at the
purchasing cost Tk. 12007 We frequently need to do this sort of calculations in
Uurpracucalhfe Wemdothmcalculahmmﬂ:espreadsheet

To solve the first problem om the
|| spreadsheet, put formula =A3*B3% in
- the result cell. The process of writing the
formula in the result cell by using
| keyboard is to write the sign = and click
"~ the cell where 400 iz written. Then
press * and click the cell where 15 is written. Then writing % (press shift key and
5), press the enter button. You will get your result.

The formula =A3*B3%+A3 should be used to solve the second problem. The
process of writing this formula i similar to the process mentioned above,

Activity

Solve the problems of calculating percentage under the guidsnce of your
teachers.

The monthly besic salary of Mr. Chowdhury is Tk 16500. He draws residential
allowance at the rate of 55% and medical allowance Tk 700. He subseribes Tk
90 to the benevolent fond. What i3 his monthly net salary?

* Becamss of the vergicn of poftwmre there may be difference in tile and meny bar,
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Exercise
1. Why is a document saved as a template?
A. For Aesthetics B. For frequent use
C. For rearrangement D. For the facilities of making copies
2. Which one of the following is used for saving the document for the first time?
A. New B. Open
C. Save D. Save As

3. By using spreadsheet analysis —
1. preparing a text is easier.
ii. a theory can be applied.
ii1. data can be arranged.
Which one is correct?
A 1&ii B. i&iii
C. ii&iii D. i,ii &iii
Read the section below, and answer the question nos. 4 & 5:

Soumitra writes on nature and environment for a newspaper voluntarily.
Sometimes he has to attach picture of flowers, birds, or rivers. He is an
accountant by profession. He has to keep the account of the employee and
place a monthly report.

4. Which software does Soumitra has to use for his voluntary work?

A. Word Processor B. Spreadsheet

C. Graphics D. Database
5. In his professional work, Soumitra has to use —

i. the template.

ii. theory.

iii. data arrangement.
Which one is correct?

A i&ii B. i &iii

C. ii &iii D. i,ii &iii
6. What kind of formatting is used in word processor for making a list?

Describe with examples.
7. Write five advantages of analysing spreadsheet.
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After complefing this chapter, we will be able to—
» explain the concept of mmltimedia;
» describe the method of multimedia;
» identify the fields of using multimedia;
¥ explain the idea of presentation software;
» analyse the significance of presentation software;
» describe the technique of using presentation sofiware;
¥ explain the idea of graphics;
» describe the technique of using graphics software;
» prepare slides on different topics by using presentation software and
present it;
» draw creative pictures by using graphics software and present it.
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Multimedia and Graphics

Human beings have been using different media to express themselves since the
ancient time. Writing is an expressive medium, and so are the sound and image.
Multimedia is the integration of multiple forms of expressive media, such as
texts, graphics, drawings, photographs, videos etc. With the evolution of
civilisation and development in technology, these mediums have been used in
various ways. Specifically in today's digital era, the nature of these media has
also changed.

The media of the analogue age are not the major media of the digital age. Rather
the media of analogue age have changed in motive. Once, the media were used
separately, but nowadays they are harmoniously combined together. The
potentiality of multi-media has been enhanced with the integration of
programming ability of digital machines. Hence, it is also called 'interactive
multimedia' because of its multiple dimensions and different programming
abilities. Interactive multimedia is widely known to people. In summary,
multimedia means numerous media. Interactive media means the media with
which the users can connect and interact.

Multimedia is the combination of different expressive media. We express
ourselves by using, at least, three media which are colour, image and sound.
These three media have various forms too. They appear before us either
individually or collectively. Different kinds of media are known to us, such as
paper publication, radio, television, video, cinema, video games, educative
software, webpage, etc. We can call television, video, and cinema multimedia,
but video games, educative software, and webpage are called interactive
multimedia.

Multimedia is usually captured by a digital machine or device. It can be directly
presented on the stage or projected in a different way. Sometimes some
electronic devices are called multimedia because they contain the information
and directly display it in different forms. If we want to use three media in one
activity, we should start from the cinema. In the last phase of 19th century, in
1895, with the invention of cinema, text, graphics, sound and movement were
added to it. Therefore, cinema is called the earlier invention of multimedia. Even
though this form of multimedia came into being ages ago, the integration of the
computer to it is a quite a recent development.

Media of Multimedia
We know that the computer, the most popular digital device, is widely known as
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the calculating machine. Processing and transferring data was another important
work of the computer. Later on, it was widely used for typing.

In the beginning, only one medium was used to do all these works, i.c. text.
However, gradually graphics and sound were used too. Besides, the computer
has the ability to do programming. In fact, computers are capable of creating an
interactive experience for users with the combination of text, graphics and
sound. Now multimedia promised dynamic experiences than that of the previous
time. Multimedia is used not only in the computer, but also in mobile phones,
smartphones, tablets, and other digital devices.

The main mediums of Multimedia

There is a world-wide preferences for computers and they tend to replace the
conventional machines.

1. Text: Any work in relation to written text is done on computers world-wide.
Once it was done by the typewriter. At present, computers are used for all
kinds of writing tasks in offices to professional printing houses.

2. Graphics: Computers are used for graphics design, editing, and so on. In our
country, the use of computer is very limited in graphics design, painting,
drawing, and even in commercial graphics included in Fine Arts. However,
computers are widely used in printers and packaging industries. The use of
computer started in 1990s in printing, publication and graphics design. It was
first used to edit scanned photos by Photoshop. Gradually, computers have
been used in design and graphics.

3. Video: Video is a kind of graphics. It is better to call it a moving graphics.
Video is an established medium all over the world. Video has been extensively
used in TV, Home Video, Multimedia Software, Web, etc.

4. Animation: Animation is a kind of graphics. But it can be either moving
or static. It can be either 2D or 3D. The use of animation is gradually
increasing in our country. In advertisement, animation is a favourite
media, but we lack skilled people in this sector. In fact, animation
is never used as a single medium. It is combined with audio, video,
text, graphics, etc.

S. Sound or Audio: The whole world depends on computer for sound or audio
recordings, editing, etc. The analogue system has been completely rendered
obsolete in sound engineering. Now sound recording can easily be done in
computers.
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6. Interactive Computing: In this connection, we should know a piece of
information about interactivity. Application of any style, such as Microsoft
word scroll or flash, into the text or any effects of animation into the video
does not make the text or video interactive. Something created by the
powerful authoring software like ‘Flash’, ‘Director’, and ‘Authorware’ that
makes interaction possible between the user and the computer is called
‘Interactivity’.

Use of Multimedia in ICT
There is an increased use of multimedia in ICT.

1. As teaching aid : The use of multimedia as a teaching aid is widely used.
The learner will understand a topic easily, if multimedia is used in the class
room. The teacher can easily make the lesson effective and interactive.
Beside this, there are various kinds of multimedia software for education.

1.1. Multimedia Software : The multi-media software has just started being
made in Bangladesh recently. Multimedia technology has been used in
with 'Bangladesh-71', 'Abosor', 'Biswakosh', 'Namaj shiksha', 'Bijoy
Shishu shiksha', etc. They are not much interactive. However, we expect
that in Bangladesh, multimedia software will be definitely developed
extensively in the 21st Century.

1.2. Digital Publication : Our publication is still paper-based, but the
21st century will definitely be the century of digital publication.

2. Entertainment : Multimedia is widely used in most of the genres of
entertainment. Cinemas and plays are being made livelier by the special
effects of multimedia.

3. Advertisement : Because of the use of multimedia, advertisements have
become attractive. Both real and fictional elements can be shown in
advertisements with the help multimedia.

4. Games : Multimedia is extensively used in computer games or video
games. Because of the use of multimedia, the games seem as real as real
life.

The man who works with text, graphics, audio, video, animation, etc. is called
the multimedia content developer. Many pieces of software like Adobe
Photoshop, 3D Studio Max, Maya, etc. are used for multimedia contents.
However, depending on the content that they develop and the interactive
applications that they use, multimedia contents developers should be called
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‘multimedia programmers’ or ‘multimedia authors’. In fact, there is a
difference between developing contents and adding interactivity. Adobe
Premier and Adobe Photoshop can make an interesting piece of multimedia
content. By contrast, in order to make the multimedia content interactive,
‘Director’, a programme of creating software, combines the media made in
‘Premier’ and ‘Photoshop’ and creates an interactive application.

In future, the demand and the number of multimedia programmes will definitely
never lessen. The demand of multimedia content developers and programmers,
along with business software developers and maintenance experts, is also
increasing.

Presentation Software
Creating Presentation

It is the age of exchanging information and ensuring human welfare through free
flow of information. Now, the exchanging of information among the
researchers, educationists, social workers, and professionals of national and
international levels has been emphasized most. Meetings, seminars,
symposiums, and workshops are frequently arranged in order to ensure free
access to information. As a result, experts have up-to-date information about
their respective fields.

Presentation softwares such as PowerPoint, Picasa, Impress etc. are mainly used
to present information in an attractive and effective way in meetings, seminars,
symposiums, and workshops. ‘PowerPoint’ is a piece of popular software or
application of Microsoft Office. It is called ‘Presentation Software’ too.

Information can be presented attractively with texts, graphics, audio and video
through Power Point. In fact, right at the moment there is some alternative to
Power Point software. That is why it is widely used for presenting information
in meetings, seminars, symposiums, and workshops.

Just a word document in a Microsoft Word Programme, has numerous pages, a
Power Point presentation also has several slides. A page containing more than
one slides is called ‘Handout’. A draft should be made for organized presentation
in Power Point. This draft is called ‘Slide Layout’.

Opening Power Point Programme and Creating Slides

To open Power Point Programme -
o~

1. At the left corner below the screen, ‘Start’ is written. It is the ‘Start’ button. &
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7.2

3.

4.

- *Click to add title' and ‘Click to add Click to add title

Click the *Start’ button by taking the mouse pointer on it, and a menu will be
viewed on the screen.

Place mouse pointer on the ‘All Programs’ command and get a ‘Fly out’
mem..

Click the “Microsoft Office’ menu from this ‘Fly out’ menu and get the list of
allthepmgrmmnesnmemsuftOﬂ'icennanuther ‘Fly out’ menu,
Select the ‘Microsoft Office Power |~~~ _-,T'-‘-“‘_‘_w
Point’ command from thig listandthe |~ = e

first slide will be showm on the | |
screen. In the main part of the slide. | 790

subtitle’ are written on the box.
Click both the writings and a text
box will be shown with the ingertion
pointer. Type a title and subfitle while ™ =T
ﬂ:.emsertmnpomterlsmﬂmbox.lfynuchckuumdethehoxmthuut
writing anything those two writings will be viewed again.

Click the textbox border and press delete button after selecting, the textbox
with the writing will be deleted.

Select the textbox icon from the ribbon of the ‘Home’ menu and take the
insertion pointer inside the screen and the insertion pointer will be changed
into a text pointer. { create a box, dragging)

The insertion peinter will be on the box.

The keyboard will be transformed into ‘Bangla’ for typing in Bangla.
Select font, fontsize, colour, etc. ﬁumﬁcmulbarandn'bbnnfortypmgwork.
‘omoE ot is typed selecting | o
Sutonny MJ, font size 150 and blue '
colour. -

The textbox will remain selected
round and hollow selection poinis,

four on the four arms of the selected _ e FE—
box and four on the four comers. Draggmgthﬂs:seluenunpnmrs thesmaof
the box can be made small or big either sideways or from the top to the

Forma-10, KKT- 9-10
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bottom to contain texts. The selection will go away if you click outside the box.

- The box can be moved to any place of the screen by clicking any arm of the
box and by dragging it.

- On the left side of the slide making window, the small version of the slide is
shown in thumbnail view.

Saving Presentation

- Give the Save command from the file metm, and Save as dialogue box will
come,

- Type the name of the file in Save as dialogue box. Suppose that the name is
‘My Country.’

- Click the button ‘Ok” in the dislogue box, end the presentation will be
saved as ‘My Country’.

- The file can be opened next time to complete the unfinished work.

Adding New Slide
Many slides may be included in & single presentation, To add a new slide

1. Select the command of New Slide' on the ribbon of the "Home' memu or
Press Crl+M from the keyboard. A new slide will be added.

- ‘Click to add title’ and "Click to add text’ will be shown on the newly added
slide. Both the writings will be deleted following the previous directives.
The small version of the newly added slide will be shown on the left side of
the Window in thumbnail view.

2. Type the title of the new slide ‘W™ TF @F1GT" in the textbox following the
process described earlier.,

3. Following the same process, type the three titles in three different boxes:
SHEX TR XY oI Wi WM o

ity ARTOR WO i T 6 9say
AW e W W e fRe) q @
O TR

S59% TRT S s wiaioRr Reer fier) «
e Yo fwm wcew ooow Moy ST
e sl o
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The three boxes will be placed one after another from top to bottom. The
title will be on the top. Another slide will be added following the process of
adding the second one. That will be the third slide. To add this slide

Type ‘WA as the title of the new slide P ———
in the textbox following the process | e [

described earlier,

By adding numerous slides, complets the ——
work of presentation as required. SOIGILG
After preparing the primary presentation,
presentation attractive.

Display Slides in Presentation

Making two slides for presentation, check it whether it has been workable as
well as presentable. For completing the task,

Press the button F5 from the keyboard or select the Slide Show on the ribbon
of the View menu or click the icon of Slide Show on the status bar, the first
slide of the presentation will be displayed.

For viewing the next slide of the presentation, press the right arrow of the
keyboard, and to go back, press the left ammow.

For starting the next slide show from the middle of the presentation, press
Shift FS button,

Press the Eac button to revert to the window of editing from the window of
slide show.

You can be sure whether the slides are presentable or not by checking at any
phase of preparing the slides.

Changing the Background of Skides

The color of background can be changed either during the processing or afier

the making of the slides. Any image can be used as the background of the
slide.

Adding or Changing Background to the Slde

1.

Keep the slide open or active to add a background to it. The first slide of the
current presentation is kept open.
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2, If you click on the drop-down bar of T — ——
Background Style on the right of the . '« = . =@ = ==
ribbon of the Design menu, a palette of =
gradient and solid color will come on the S,
screen. If the mouse pointer ia placed on a '
color or gradient of the paletts, in the
original slide, the background of that
color or gradient will appear.

To use more colors, textures and images A

1. Select Format Background at the bottom, and a dialogue box of that name
will come on the screen.

2. Clicking the Solid Fill Radio button on the left above the Format
Background dialogue box, make it active. Click Color Drop-Down Arrow,
snd a color palette will be viewed on the screem. The color swatch, which
will be clicked from this palette, will fill the background of the slide.

3. Clicking radio button of Picture or Texture Fill, make it active, and Texture
drop-down will be viewed instead of coler, Click this drop-down amrow,
and different kinds of texture will be shown. The texture swatch, which
will be clicked, should be selected from the original slide.

4. The dialogue box called Insert Picture will come if the File button below
Insert Box is clicked as the radio button of Picture or Texture Fill is selected.
Select the picture opening the folder of the dialogue box that contains the
picture.

5. Click the Insert Box button of the dialogue box, and it will disappear, and
the picture will be set as the background of the slide.

6. To remove the imposed background -

Click the Solid Fill radio button of the dialogue box of Format Background
and make it active, Click the drop-down ammow of Color, the palette will be
viewed on the screen. Select White from this color palette.

7. Click the Close button of the dialogue box.

Imgert Picture in Shide

Sometimes, it may require to insert a picture on the slide.
To insert a picture into a slide

e

.Iilmm
el
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1. Click the icon of Picture on the ribbonof [ <= ha=
the Insert menu, and the dialogue box of | ' = =~ % 0
Insert Picture will come on the screen. |-

2. Open the folder of the dialogue box of
Insert Picture in which names of pictures | &
are available. After selecting the picture
you prefer, click the Insert button. The
selected pictre will be added to the
slide.

3. Clicking the resize box and dragging it, the size of the picture can be
resized and replaced elsewhere, if required.

Inserting Transition into Slide

Usually slides are presented one after another, and effects are used to ghift
from one slide to another. This effect is called “Trensition’. It works on the
slide into which transition is applied by keeping it open. To insert Transition
into a slide

1. Keep the first slide open.

2. Click the Animations menu to activate it.

Anmmations Shde Fhowr Review View

ﬁ[lm.w'

- g Transition Saum

E_Jl iM| L U Transition Speec

T pad Sppdy To &N

Trangtion 1o Thi Slhds

On the ribbon of Animations menu, a row of Transition samples will be viewed.

On the ribbon of Animations menu, & row of Transition sample will be viewed.
The sample on which the mouse pointer is placed will be viewed in the slide.
There are three arrows on the right to pick more from the given samples. If you
click repeatedly on the middle arrow, a new row will be viewed with every preas
of the mouse button. If you click the arrow on the top, a column will appear. If
you click the arrow at the bottom, all the samples will be viewed. Click the
sample chosen, and the transition will be applied to the slide.

3. If you want to apply the same transition to all the slides, click ‘Apply to

AIll’ button on the right side after applying it to the first slide.
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4. If you want to apply a different transition to every slide, you have to apply
it separately following the same process for every slide.

Applying Transition Separately in Text

One slide may contain several textboxes. There are texts in three textboxes in
the second slide of the current presentation. If different transitions are applied
in these three textboxes, they will come to slide in three different processes. To
insert transition to the textbox

1. Keep the second slide open.
2. Select the textbox.
3. Click the Animations menu to activate it.

A command called Custom Animation will be added to the bottom of
Animation. Click Custom Animation and a palette will come.

4. Select Entrance from the Add Effect drop-down list of Custom Animation,
and a list of custom transition will appear. From this list

- ‘Blinds’ is selected for the first textbox.
- ‘Flyin’ is selected for the second textbox.
- ‘Diamond’ is selected for the third textbox.

- Ifyou select ‘More Effects’ from this list, another list of transition will be
viewed. Selection of any transition from this list will show the same effect.

5. In order to remove a transition from a specific textbox, select it. Click the
‘Remove’ button to exclude the transition.

Apply Sound to Transition

Keep the slide open to add sound to the transition, and select the name of a sound
from the drop-down list of Transition Sound. Camera is selected for the first
slide. Click Apply to All button for applying the same sound to all the slides.

If different sound is required to apply in every slide, separate application of
sound following the same process for every slide will be needed.

Add Video to the Slide

Video can be added to any slide, if necessary. Usually video is added to the
introductory slide. Suppose that video will be added to the introductory slide of
the presentation on Our Country. For this
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- Keep the introductory slide of the presentation open.

- Clicking the Movie drop-down on the ribbon of the Insert menu, get ‘Movie
from the file’ command. Select the command and ‘Insert Movie dialogue
box’ will come.

- A movie file will be selected from the video folder of the Insert Movie
dialogue box.

- Click the Ok button of the dialogue box.

- A message box with a question ‘How do you want the movie to start in the
slide show?’ will appear.

- The Messaging box will contain two buttons ‘Automatically’ and ‘When
Clicked.’

- The Messaging box will disappear if required button is pressed, and the
video file will be added to the slide. You can place the file anywhere on the
slide by dragging it and resize it by dragging the resize box.

- The first slide will appear on the screen if you press F5 on the keyboard.
- The Thumbnail view of the video file will be shown on the screen.

- Click the Thumbnail of the video file and it will start playing.
If Automatically’ was selected at the time of adding the file, it will start
playing with the display of the slide.

Activity

Make a power point presentation about your school and present it.

Graphics
Importance of Graphics

Photographs, drawings, paintings, illustrations, designs, etc. have to be scanned
and transferred to the computer first for editing. Now pictures captured by a
digital camera can directly be copied to the computer. After the editing, these
photos can be used on printed invitation cards, posters, banners, advertisements,
etc. through the digital media.

There are numerous programmes to edit photos in computer. Of these
programmes, Photoshop is popular worldwide. Brightening or darkening the
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entire or a part of picture, designing the cover of a book with several pictures,
making posters, cutting off any irrelevant part of the picture, erasing blotchy
marks on the picture, etc. can easily be done by Photoshop.

Photoshop, an editing software should have been installed in the computer or it
should be installed. Editing can be done on a file created earlier.

To open Photoshop program

1. Click the start or Logo button of Windows and place the mouse pointer on
the ‘All Programs’ command, and get the Fly out menu.

2. Click Adobe Photoshop Programs, from this menu and ‘Adobe Photoshop’
will open.

To prepare new file in Photoshop program

- Click ‘New’ from the ‘File’ menu after opening up the Photoshop program,
and get New' dialogue box.

- You will get ‘Untitled-1" selected in the square space of ‘Name’ of the
dialogue box. Pressing the backspace button of the keyboard, erase the
writing and type a name. It will be the name of the file. Suppose that
‘Practice’ is typed in the ‘Name’ box.

If you type the name in this stage, you need not to type it further. While
closing the file, a new dialogue box will come when you will go to close the
file.

- In the box of ‘Width’ and ‘Height’ in New Dialogue Box, type numbers on
the measuring unit ‘inch’, for example, width of 7 inches and height of 8
inches. There is a dropdown menu to determine the unit of measurement on
the right side of these two boxes such as inches, pixels, piacas, points, cm,
mm. Select the requisite unit from this dropdown menu. Fix the
measurement by inches. Suppose that the measuring unit of the present task
is inch, and 7 in the box of width and 8 in the box of height have been

typed.

- The Resolution, for example, 72 Pixel, is kept unchanged.

Images or pictures are created in Photoshop by pixels. Pixel is the smallest
square unit of image. 72 pixels per inch mean crossing 72 lines vertically and
horizontally in per inch space. The total number of pixels in one square inch
will be 72°72= 5184. The number of pixels in per square inch is called
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resolution. If 130 is typed in the box of pixel, the resolution will be
130°130=16900. If an image is enlarged, the pixels could be visible. This view
is called pixelated. In simple words, it is called split image.

From the dropdown menu of color mode in the dialogue box, RGB,
CMYK, Bitmap, Grayscale, and from Lab Color RGB can be selected as
all the images on the monitors of computer, television, and other electronic
media are viewed in RGB mode. RGB is the abbreviation of red, green and
blue.

There are three options in the ‘Background Contents’ of the dialogue box.
The options are White, Background and Transparent.

If “White’ is selected from the dropdown menu, the background will be
white. If a colour is selected from Background toolbox, it will turn into the
colour of the canvas. If transparent is selected, the background will be
transparent and checkered. The background option can be selected as you
like. White can be selected here too.

Without following the steps described above, Default Photoshop Size can
be selected from the ‘Preset dropdown list. Thus, all the units of Photoshop
will be selected as per the requisition.

Completing the measurement of the dialogue box, press ‘OK’.

A window will be viewed as per the measurement given in the dialogue
box. On the left of the screen, Practice @ 100% (RGB/8) will be viewed.
This bar is called the title bar. If any name is not used in the Name box of
the new dialogue box, Untitled-1@ 100% (RGB/8) will be viewed on the
title bar as the file name.

Double click on the title bar, and it will be viewed on the screen.

The menu bar is located under the title bar and the option bar is below the
menu bar.

The ruler is located below the option bar.

The Photoshop work is to be done below the ruler on the screen.

The screen can be compared to the canvas of painting of an artist. On the left
side of the canvas, are the brush, color, and different kinds of editing tools, and
on the right side is the palette.

Forma-11,ICT-9-10
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The Toolbox of Photoshop and Palette Distinction

At least 69 kinds of tools are there in the Photoshop. Besides, numerous options
of palettes, dialogue boxes, etc. are there. There is a relationship among different
tools, option palettes, and dialogue boxes.

In addition, the brush colour or foreground and colour control icon are there for
the canvas or background and visual space control icon for the monitor, mask
icon, etc. If & line is drawn either with the pencil or with the brush tool, the color
of foreground works as the color of brush.

- Different palettes are kept on the right side of the screen, The minimise icon
is viewed above the right side of the palette. The palette will be minimised if
you click the minimise icon. It will be again extended if you click the
maximige icon.

- If you double click on the top bar of the palette, it will be either maximiged
or minimised.

- Clicking and dragging the top bar, the palette can be replaced anywhere.

- There is a toolbox on the left side of the screen. It has included different
kinds of tools for different jobs. The tool, which is required to work,
becomes activated when clicked. If the mouse pointer i taken ingide the
screen afler selecting a tool of the box, the tool is either viewed on its
actual size or ag a plus (1) sign, and the editing tools are viewed as circles.

2
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Selection of Tools and Acquaintance of Move Tools

3 selection tools and 1 move tool are viewed on the top of the tool box. At the
bottom of the right side of some tools, a small arrow gign Z is viewed. It
indicates that in the same position, more tools of the similar types remain
there, For example, 4 Manquee tools in the same pogition and 3 Lasso tools
in different positions are there.

Place the mouse pointer on the tool, and the name of the tool will be
viewed. Click the tool to activate it. If the mouse pointer is brought inside
the screen, it will be viewed either in the own shape of the selected tool or
with a plus {+) gign,

Making squares, circles and objects is possible with the marquee tool within
the selected tool.

By pressing the shift button and dragging Rectangular Marquee Tool, a
perfect square, and pressing the shift button and dragging Elliptical Marquee
Tool, a perfect circle can be drawn. If you drag while pressing the Alt button,
selections of square and circle can be extended from the centre point.

Shifting of Selection

Fill Colour in the Floating Selection
There are colour icons of ‘Foreground’ and

File Edit Im

After making the square of selection by Rectangular Marquee Tool,
remove the finger from the mousge, and the selection of square will be
viewed on the screen.

If you take the mouse pointer ingide the selection, a rectangular icon will be
viewed below the pointer. Pressing and dragging, the selection can be
shifted elsewhere.

Select the Deselect’ command from the Select menmu or click the mouse
pointer outside the selection while it is floating. It will go away.

‘Background’ at the bottom of the toolbox.
The icon above is for ‘Foreground’ and the
icon below is for the ‘Background’. To fill a
selection with colour while floating:

Press Alttbackspace, and the selection will
be filled with the colour of the brush or
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Foreground. If you press Cirl+backspace or only backspace, it will be filled
with the colour of Background or canvas.

The selection filled with colour will float. It can be shifted elsewhere by
dragging,

The object will stay at the same position after shifting the selection.

If the shifting is done by pressing the Ctrl button, the object being shifted
will be cut.

Press Cir] and Alt during shifting, and the object being shifted will be copied.
The selection will go away if you click the mouse pointer outside the
selection.

The Use of Feather

Typing the number from 0-250 in the box of feather on the option bar, the
edge of the object can be softened. The room of the feather extends equally
from the edge of the object to the inside and outside. If 10 is typed in
the feather box, the softness of the edge will be 20.

The feather effect will be activated by pressing enter button after writing
different numerical figures in the box. Fill colowr by using either the
rectangular marquee tool or the elliptical marquee tool, and the effect of
feather will be vigible then. The effect will be still viewed after pasting the
cut or copied object.

Select with Lasso Tool and Pelygonal Lasso Tool

Select the lasso tool in the toolbox. FE=T——
lesso tool such as
Clicking and dragging on the canvas after | 8.
selecting the lasso tool, selections of | . *

g non-circular and uneven edges can be |0
made. If you release the finger from the = ||
pressing position on the mouse while |50
dragging, a closed selection will be |

created from that position to the first
By clicking ingide the selection while floating, it can be shifled elsewhere by

8
™~
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dragging. Filling any floating selection with colour, it can be filled either
with the same or a different colour.
Opacity is used to determine the thickness of colour.

The 'Fill' dialogue box will come after giving the 'Fill' command under the
'Edit' Menu.

The foreground is kept selected in the ‘Use’ box of ‘Contents’ under the
‘Fill’ dialogue box. It can be changed from the list of the dropdown menu, if
required.

In the opacity square of the dialogue box, type a number to determine the
thickness of colour. The full intensity of colour is 100%. If the percentage is
small, the colour will be light. Type 50 in the Opacity box, and click the OK
button, and the foreground of the selection will be filled with 50% of the
total thickness.

There is opacity in the option palette of selection too. The intensity of
colour can be increased or reduced by selecting the opacity of this palette.

Stroke

The border of the selection can be made with the ‘Stroke’ command.

Select the ‘Stroke’ command under the 'Edit' menu as the selection is
floating, and you will get the 'Stroke' dialogue box.

Any number from 1-16 can be typed in ‘Stroke Width Box’. The extension
of the border is determined with this number. To create the border outside,
inside or at the middle of the selection, activate any of these three options
by clicking the radio button attached with them.

Click the ‘Ok’ button of the dialogue box.

Borders can be created either by using the colour of the brush or of the
foreground in the Stroke process.

Saving File

Give the ‘Save’ command from the ‘File’ menu, and the ‘Save As’ dialogue
box will be viewed.

In the box of ‘File Name’ of the 'Save As' dialogue box, type the name of the
file, for example, Practice’.

Click the ‘Ok’ button in the dialogue box, and the file will be saved as
‘Practice’.

‘Practice’ can be opened for further work later.
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Layer

An idea of Layer is required before cresting objects or editing photos. Almost at

every stage of editing photos, you have to work through Layer.

Layer is the screen of editing photos or the phases of a canvas. In this process,

editing can be done by putting numerous transparent canvases one after another.

If the canvas is transparent, editing becomes easier as the existing photos can be

watched, but if the canvas of the upper layer is not transparent, the editing of the

lower layer cannot be seen. If any photo with colour background is opened,

Backpround' will be writien on the layer palette. The background will not be

transparent in spite of being white because white is a colour.

- Suppose that a file with the
picture of a flower is opened.
‘Background’ is written on -
the layer palette. An iconof a
lock is viewed to the right of |
the layer bar, It indicates that |
the layer has been locked
The object of a locked layer [ E_—_.
cannot be shifted by clicking
or dragging with the ‘Move’ tool.

- If "White" is kept as ‘Background Content’ and ‘Background’ while opening
a new file, ‘Background” will be viewed on the layer palette.

- ‘Background’ can be transformed into a layer to shift the sample picture of the
flower elsewhere.

To accomplish the task 1 T =
5 -+ - l"‘."‘""- it H"ﬂ"‘— = ‘.
- Double click on | B T

‘Background’ of the layer | & el Al B T
palette, and a dialogue box : =t

named ‘“New Layer® will be |
shown. In the ‘Name’ box
‘Layer 0’ will be viewed
Click the OK button of the |* : .

dialogue box, it will d:lsapp&ar and the ‘Background layer will be
transformed to ‘Layer (°. The ‘Background’ layer will be ‘Layer 1’ if it is
written after erasing ‘Layer 0° in the “Name’ box of the dialogne box.
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- Ifyou click on any part of the picture with the ‘Background Eraser’ tool, that
part will be erased, and the layer of the palette will automatically be
transformed into ‘Layer 0°.

- If any part of the picture is erased by the Eraser tool, the layer will not be
transformed into ‘Layer 0.

Insert New Layer

Many layers should be used to work with more than one file in Photoshop. By

keeping different pictures on different layers, their arrangement and editing
should be done.

To add new layers in palette

- Click the ‘Create a New Layer’ icon below the palette, a new layer will be
added above the existing or selected layer. This layer will be a transparent
one. To create any new object in the newly added layer, shift it elsewhere if
required. If five layers are created in this way, layer no. 2 will be above layer
no. 1, no. 3 will be above no. 2, no.4 will be above no. 3. If more layers are
added, those will be arranged serially.

- The arrangement of steps can be changed it required clicking layer no.2 and
pressing on the mouse, drag it and release on layer no. 3, and it will be placed
in between layer no. 3 and 4. After the selection of dividing line between two
layers, release the pressure on the mouse.

You should remember that ‘Background Layer’ can not be shifted in this way.
Background should be transformed into layer to replace it into another stage.

Make Picture Visible and Invisible on Layers

There is the icon of an eye on the extreme left of every layer. This icon is called
‘Layer Visibility Icon’. Click on the icon of eye, it will disappear along with the
picture on the screen. Click again on the empty place of the eye, and the icon will
be visible again, and the picture on that layer will be visible again. The picture

of the flower on the layer can be made visible and invisible for
experimentation.

Thumbnail Icon

There is a thumbnail icon on the right side of the icon of eye. The meaning of
thumbnail means the miniature version of a large picture. This miniature version
on the layer along with the picture on the screen is viewed in the thumbnail icon.
It facilitates the editing of the pictures on particular layers.
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Clustering, Integrating and Segregating Palette

Numerous palettes can be panelled together. For example, Layer, Path and
Channel can stay together. The names of the palette will remain as tabs. The tab
which is clicked will be activated. The combined situation of several palettes is
called clustered palette.

- The present palette is activated as a ‘Layer Palette’. Click the layer tab and
drag it outside the palette to release. The Layer palette will exist as an
individual or single palette.

- Again clicking the tab of the individual Layer, release another palette
inside by dragging it. Thick lines around the palette will be viewed. Thus
the Layer taken by dragging will be included in the cluster.

- If the ‘Layer’ palette is not viewed on the screen, select the ‘Layers’
command from the ‘Window’ menu, and you will get the ‘Layer’ palette.

Making Layer Object

The process of making Selection and filling it with colour has been learnt. Now
we will learn how to make two simple objects with rectangular and circular
selection tools. We will learn how to write using the text tool too.

A. Creating a rectangular object on Layer no. 1:

- Select White from the option of Background Contents of New dialogue box,
and Background will be the base of the Layer palette. For making a
transparent layer on a white background.

- Click on the icon of Create a New Layer below the palette, and a new
Layer will be added above the selected layer. This will be Layer no. 1, and
it will be transparent too.

- A rectangular selection will be created on Layer 1 with the Rectangular
Marquee Tool, and that will be filled with green colour.

- The rectangular object can be shifted elsewhere by the Move tool.
B. Insert Layer no. 2 in the panel, and make a circular object:
- Click on Layer no. 1, and it will be selected.

- Click the icon of ‘Create a new layer’ below the palette, and it will be a
transparent layer.
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Or

If the New Layer command is selected from the dropdown menu of the layer
palette, the New Layer dialogue box will be viewed. In the square space of
the Name of the dialogue box, Layer 2 will be viewed. Type Circle in the
Name box and press the Ok button, and the dialogue box will disappear. A
new layer named Circle will be inserted above layer no.1 in the layer paletic.

Now create a circular selection with the Circular Marquee Tool so that half
of the circle will rest on the green field and the other half on the white,

The selection will be filled with red colour, and a red circle will be viewed
in thumbnail of Layer circle.

C. Preparing Text Layer

You should keep in mind |®0
that if text is started with
the Type tool, the text will
automatically be written
on the Text layer. The new
text layer will be
transparent.

To write on Text Layer:

Click on the canvas selecting the Type tool from the toolbox, and instantly a
new layer will be added to the Layer Palette.

Selecting the Text tool, click the mouse pointer on the canvas, and the
requisite dropdown option list will be found on the Option bar to determine
the font, font size, etc.

Select SutonnyM.J from the dropdown list of fonts.

The size of the font will initially be selected 72 from the dropdown list of
font.

The font colour will be initially black.

Type ‘W @, and it will added &s & new layer. The letter ‘T will be
viewed as a thumbnail of the text layer on layer palette.

The text can be shifted elsewhere with the Move tool or the mouse pointer,
Now the square, circle, and text can be shifted anywhere with the Move tool.

Forma-12, ICT-9-10
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- If the combined position of the three objects is satisfactory, the file can be
saved for further use.

Transferring Picture from One File to Another

All the pictres should be transferred to a single file to work together. Prepare
an empty file named Default Photoshop Size. Another file called Banana is
opened with the pictures of bananas. Now clicking on a banana with the Move
tool, and drag it to the Window of the empty
file. The picture of the banana will be shifted to
the empty file. Close the file of Banana.

In the same way, more pictures of mangoes,
pincapples, etc. can be prepared and shified to
the new file.

Fixing Target Layer

- The layer in which the picture i edited is called Target Layer.

- Any picture of any layer can be edited whenever required. The picture of a
gingle layer can be edited once.

To change a layer into Target Layer:

- Click the mouse pointer on the layer, and the layer will be changed into the
Target Layer. The Layer will be viewed and aelected then.

Changing the Opacity of the Layer

-  Opacity is the intensity of colour. In the opacity text box on the right side
above the Layer palette, 100% is viewed as the full intensity of colour, If
you put mouse pointer on Opacity, it will be transformed into a
two-pointing arrow. When it will be dragged to the left, the opacity will
decrease, and when it will be dragged to the right, the opacity will increase.

- Or by typing a numerical figure in the opacity textbook the opacity can be
changed.

Removing Layer

Select the Layer to be removed. Then

- Give the Delete Layer command from the pop-up menu of the Layer palette.
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Or

- Afler selecting the Layer, click the icon of Delete Layer below the palette,
and a dialogue box with a question, “Are you sure you want to remove this
Layer?’ will come. If you click the “Yes’ button, the layer will be removed,
but if you click ‘No’, the removal process will be stopped.

Combining or Merging Layers

Sometimes it is required to edit all the layers together in Photoshop. After

finishing the task, if it is required to take a print out by a different printing

machine, it should be copied on CD or pen-drive. The size of the file will be

small for getting this task done smoothly. The size of the file will be

comparatively small if the layers can be combined.

To combine layers

- There are three commands called Merge Visible, Flatten Image, and Merge
Down on the pop-up of the Layers palette.

- If any layer ig invisible, give the command of Merge Visible, and only the
vigible layers will be combined.

- If the Merge Down command is given, the selected layer and the layer below
of it will be combined.

- If vou choose Flatten Image, all the layers will be combined.

- If there i8 any invisible layer, an inquiring message will come whether it
will be removed or not. Click the Yes button, and the invisible layers will be
removed and the visible layers will be merged.

Cut, Copy, Paste and Paste into

You may select any object or image either fully or partially, and cut, copy and
paste it. If you paste any object after cutting or copying, a new layer is created,
end the object is pasted on the new layer. If any transparent layer is created
before pasting, any cut or copied object can be pasted on the layer.

The Use of Crop Tool

The border of pictures collected
from different sources can not be B8
perfect or precise. It can be J
required to cut off the edges or "'
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unnecessary parts. In spite of that, the image can also be tilted to one side.

Before starting editing, this kind of problem can be mended. The Crop tool is
used to cut off the unnecessary parts of an image. Crop means cutting off.

The border of this old picture is uneven, and the first step of editing the
picture will be cropping out the uneven edges. To get it done:

Select the Crop tool from the toolbox;

Select the necessary part keeping the uneven parts outside by clicking and
dragging it like the rectangular marquee tool.

Eight hollow square boxes will be viewed, four on the arms of the selection
and four on the comers. By clicking any one the boxes and dragging it, the
area of the selection can be either reduced or increased.

After fixing the selection area, press the enter button of the key board, and
the area outside the selection will be cropped.

If you think that the crop command should not be given even after selecting,
press the Esc button to undo the effect. Selection can be made again if
required.

Cropping up Tilted Picture

To crop any tilted picture, the picture is to be opened and the Crop and
Straightened Photo command is to be selected from the sub-menu of
Automate command in File menu. This process is applicable only for solid
background. If the background is of multicolor, the work of cropping will be
impossible. In that case

Select with the crop tool.

The mouse pointer will be transformed into a curved pointer or rotate tool.
The selection will be attached with the tilted position of the picture, and the
area of cropping will be finalized with other handles.

Press the Enter button, and the cropping up of the picture will be done, and
its positioning will be straight.

Use of Eraser Tool

When any color is erased by the eraser tool, the color is covered with the
color of the canvas. If the color of the canvas is white, it seems that the color

2023
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is being erased, but if the color is different, it will be viewed. The picture
on transparent layer will be simply erased.

Press Cap Lock to erase the minute detail, and the eraser tool will take the
shape of plus (+) sign. The editing of small parts will be done then.

The work of erasing can be done by selecting a brush, pencil, or block from
the list of Mode drop-down of the Option bar on eraser tool. The rubber
eraser works like an electronic version if a block is selected. The Opacity
options of other tools can be used if they have been selected.

Creating Blend with Gradient Tool

The paint Bucket Tool is kept on the same position of the Gradient Tool. If you
select the Gradient tool, icons of creating five kinds of gradient will be viewed
on the Option bar, for example, Linear Gradient, Radial Gradient, Angle
Gradient, Reflected Gradient and Diamond Gradient.

Blurring of a color from the
beginning to the end is called
blend. The color blurs from the
beginning edge to another in

linear blend. On the contrary, in radial blend, the color diffuses either from the
centre to the periphery or the periphery to the centre.

To create linear blend with gradient tool

A selection of 3 inches width and 2 inches high can be created.

After selecting the gradient tool, bring the mouse on the canvas, and it will
be transformed into a plus (+) sign. Now drag it from the left-middle of the
selection to the other end, and release the pressure of the finger from the
mouse pointer. It will be viewed that the selection starting with deep black
color gradually diffuses to the end.

A blend can be created from all directions. If anything is not selected, blend
will be created through out the screen.

Activate the radial gradient icon on the option bar by clicking it for creating
radial gradient.

The mouse after bringing onto the screen will be transformed into a plus
(+) sign. Now drag it from the middle of the selection to the other end, and
release the pressure of the finger from the mouse pointer.
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Editing Gradient

The editing of gradient can be done by starting, finishing, and changing or
combining colors in the dialogue box. To get the task done

Gradient Editor Dialogue box can be viewed by clicking on the gradient bar.
Color Stop triangles can be viewed on [Jremss———" .

the left and the right end of the | HW:’
gradient slider of the gradient editor | e =
dialogue box, and the Opacity Stop . = ~
triangles are found on the top of the - et

same dialogue box. Suppose that the e

gtarting color of a lincar gradient is *

red and the finishing touch is yellow. ‘:
To use blue instead of red

Click the Color Stop Triangle at the left end of the gradient slider, and a color
swatch will be activated at the end. Click the Color swatch and the Select
Stop Color diglogue box will be viewed. Selecting the blue color in this
dizlogue box, click the Ok button, and blue will be the Stop Color at the
left-end on the gradient bar. Now drag with gradient tool from one end to
another, and a gradient of a combination blue and yellow will be created.

If you select the Color Stop at the bottom edge and Opacity Stop on the top
edge of gradient slider, 8 diamond shaped icon will be viewed in the middle.
This icon indicates the middle point of the pradient from where the color
After selecting the middle-point icon, type a position-fixing digit in the
location box to fix the middle. The middle point can be shifted by dragging
the icon either to the left or to the right.

Adding and Removing New Color and Color Stops

If more than two colors are to be used for a gradient, add new Color Stops to the
slider. To do this

Click anywhere at the bottom of the slider, and new Color Stop will be added
to the dismond for determining color blending middle point. In the same
way, requisite number of Color Stops can be added to the gradient slider.

If any additional Color Stop is needed to be removed or cropped, click that
color stop icon and drag it to the outside of the slider, and the Color Stop will
be removed.
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Adjusting Brightness and Contrast of Picture

Pictures that have been scamned or

captured by a camera can be indistinct.

Visibility of color or black and white

can not satisfy the expectation level. In

that case, increasing the brightness and
combining contrast are required. To
increase the brightness and contrast - '

- SelecttheAdJustmantcummandﬁomtheﬁnagemenunndgetasubmenu
from where click Brightness/Contrast, and the related dialogue box will be
viewed.

- By moving the tnangle of brightness/contraat-slider in the dialogue box
either to the right or to the left, the brightness and contrast can be increased
or reduced.

- If any part of the picture is selected before coming of the dialogue box,
increasing or reducing brightness and contrasting only the gelected part can
be done by giving the command.

Activate the Preview check box in the dialogue box by clicking it, and the work

of the changing color can be viewed instantly. If the changed form does not geem

satisfactory, press the Alt button of the keyboard and the Cancel button of the
dialogue box will be changed into a Reset button. Keep pressing the Alt button
and click the Reset button, and the work previously done will be cancelled.

Iinstrator

Painting with Adobe Illustrator: Adobe Illustrator is the programme of drawing
pictures, illustrations, making logos and designs. Just as the scope of making
designs with Adobe Photoshop is limited, go is the scope of doing editing work
in Adobe Illustrator. The main job of Illustrator is drawing.

Now, the artisis of our country no longer use paint and brush for cover designing
of books. They design covers by using Adobe Tllustrator. Invitation cards,
advertisements, posters, benners, bill-boards, etc. cannot be made without the
iltustrator.

There are plenty of programmes in a computer for making designs, but the
Nustrator is popular for its facilities and varieties. That is why Illustrator is nsed
flroughout the world.
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Apart from writing in the [llustrator programme by using a keyboard, writing is
possible as an artist does by uging brush, The font size and shape can be changed
as required.

Like other programmes, open Illustrator and start making new files.

Open [iustrator Programme

To open Illustrator programrme

1.

2.

4.

Amenu will be viewed when you will click on the Start button at the left end
of the screen with the mouse pointer.

You will get a fly out menu placing the mouse pointer on All Programmes
in this menu.

By clicking Adobe Master Collection menu in this menu, you will get
another fly out menu. You will get the list of programmes of Adobe in this
meni

If you click on Adobe [lustrator from the list, the programme will open.

To Open File in Mustrator

Select the New command from the File menu or press Cirl N, and a New
dialogue box will be viewed. In the New dialogue box

Type a name in the Name dialogue [
box, for example, Ankon-1. Any | w== s =
name can be used instead of this e R v e |
one. A name which is easy tfo T T
remember or compatible with the i i
subject can be given. Finding out the e
file will be easier later on.
A detailed drop-down list will be viewed by clicking the drop-down arrow of
the size-box. Different sizes of the paper will be viewed here. The size of
paper which is required should be selected by name, and the height and
width of the paper will be seen in the box.

The units of measurement are found in Unitz box. The users of our country
are familiar with the measurement of inches, but points, picas, millimetres,
centimetres, pixel, etc. can be used to work more precisely. Click the
drop-down arrow in the unit box, and a detailed drop-dowm list will be
visible. The requisite unit of measurement can be fixed from this list.
Pictures of two people are viewed on the right of Orientation, If you click

8
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the first one, the position of paper will be portrait, and it will be in
landscape position if the second one is clicked.

- Two options are shown a3 RGB and CMYK in Color Mode. CMYK mode is
suitable for printing work, but RGB mode is better for electronic medium,
However, on the computer screen, the difference of these modes are not
precisely distinguished.

- Fixing the measurement, press OK in the dialogue box, and it will
disappear. A new window will come.

In the Name box of the New dialogue box, type a file name, and it will be viewed
on the title bar at the right side of Adobe Illustrator above the menu bar. If any
file name is not typed ‘Untitled ..." will be viewed on the title bar.

Work Tools
New vacant files will be found on the screen after creating 8 new file. Numerous
objects like menu bar, toclbox, floating palette, scroll bar, ete. will be viewed for
starting work,
Title Bar

After opening the [lustrator
Programme, on the left-end above
the screen, the other information of
the document with the name of
application on the title bar may be
viewed, for ecxample, Adobe
Niustrator-[Ankon-1 @ 70
(RGB/Preview)]. Here, Adobe
Ilustrator is the name of
application, Ankon-1 ig the name
of file if this name was given
during its creation, and @ 70
(CMYK/Preview) is the size of visible area and presentation of color mode., The
entire part stretching to the right is the title bar.
- If any name is not given during opening a file, it can be given afier
completing and saving the work too. Files are given different names, and
when a file is opened, its name is viewed on the title bar to the right of the

Forma-13, ICT- 510
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Different kinds of tools and options for designing and drawing are arranged in
Toolbox & Pelette. Dezigning and drawing can be done by using these tools
and options, and editing work is possible to get the image in its expected form.

Names of the Necessary Tools of the Toolbox

Names of the necessary tools should be known before starting work. Ellipse,
polygon, star, and spiral tools stay on the linear position in the toolbox. These are
called ‘Group Tools’, A Right-angeled triangle is attached with these tools, If a
triangle sign is attached with the tool, it means that more tools are kept in the
game position. If you click the visible tool in the box and continue pressing the
mouse, all the tools will be viewed together. Drag the mouse pointer on the
required tool and click, and the tool will be visible in the toolbox.

There are some icons in the swatch below the tools in the toolbox. Imposing
color in an object or on the edges of an object or cancelling a command can be
done with these icons. Create an object to understand the use of the icons. To
make an object like this—

Toggle column —= =

(V) Selection Tool [ | & ,| Direct Selection (A)
(Y) Magic Wand j_\__ Fx | Lasso(Q)
(PyPen & T, TypeM
() Line Segment N {& = Rectangle (M)
(8) Paintbrush &~ 7, Pencil (N)
(R)Rotate ), B3, | Scale (S)
(shift + Rywrap 1 B3 | Free Transform (E)
(Shift+S) Symbol Sprayer  "E_ |, | Column Graph (J)
{U) Mesh Tﬁ]l [. | Gradient (G)
(1) Eyedropper X 95 | Blend
(K) Live Paint Bucket & ® | Live Paint Selection (Shift + L)
(Shift + O) Crop Area 3, &7, Eraser (Shift+E)

(HyHand 2. | Zoom (2)
“it—— Swap fill/stroke (Shift+X)

%) Toggle il ——p
(D) Default flll/stroke — [l _-1— Toggle Stroke (X)
(<) Color LW Z«— None (/)

(>) Gradient

Change sreen mode {F}

2023



Multimedia and Graphics 99

Click the rectangle tool with the mouse pointer, and the tool will be selected.
Bringing the mouse pointer ingide the gereen, and after clicking elsewhere
drag diagonally right below for an inch, and releage the finger pressure
from the mouse. A rectangle or square object will be created.

The object will be selected and filled with a color.

Four hollow boxes will be viewed on the four corners of the selectad
object. Four small zolid boxes will be viewed on the four comsrs.

If the object becomes free from the selection, click Direct Selection Tool in
the toolbox with the mouse pointer, and the Direct Selection Tool will be
gelectad. Now bringing the mouse pointer inside the screen, click the object
with Direct Selection Tool, and the object will be selected. In this situation,
again click the Selection Tool, and four solid boxes can be viewed on the
arms slong with four solid boxes on the comers.

Filling Color on Object

Fill and Stroke

The edge or border of an object is
called “Stroke’ and the internal part is
called the ‘Fill’. The use of the ‘Fill’
and ‘Stroke’ swatch is related to the
color palette. If the color palette is not
viewed on the screen, cither give the
Color command from window menu or
presa the Fé6 button, and the color
palette will be visible. Click the Fill
swatch and it will be activated and
viewed above. Thus only the work of
filling can be done. Only an object can
be filled, not the stroke. Similarly, | 255
clicking the Stroke swaich, activate it
and stay over the Fill swatch, Thus, color can be imposed on the strokes of
object. It will be impossible to fill object with coler from here.

When the Fill swatch is active, click on the colour of Color Spectrum Bar of
the color palette. The ingide of the selected object will be filled with that
color. Similarly, when the stroke swatch is active and the color that will be
clicked on the Color Spectrum Bar, the strokes of the objects will be filled
with that color. The color inside the object will remain unchanged
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- Stokes can be thick for a clear view. For having this effect, select the stroke
command from the Window menu, and Stroke palette will be viewed on the
screen. Select at least 10 from the weight drop-down menu in the Stroke
palette. In this stage, if color is imposed or changed, it will be clearly visible.

Color, Gradient, and None

Color, Gradient and None are the three icons respectively W, X
below the Fill and Stroke swatch. Clicking Color and "
]

Gradient icon separately, activate the Color and Gradient
palette, Click the None icon, and the fill of selected object or
the color of stoke can be inactive or cancelled. If an object is It
filled with color or gradient, the color will be viewed. If the . =
object is selected, the color will be changed as well. 9ou
Increasing and Reducing the Size of Object
Many minute jobs are done to create object. Doing these minute jobs may be
troublesome in the usual size of the object. If a specific part of the object is
enlarged, it facilitates the task. Viewing a page in an increased size while
working in Illustrator is called Zoom in, and in decreased size is Zoom out.
Object will also be viewed either big or small with increaging or decreasing gize.
To view an object big or small, the visible size of the page will be made big or
gmall by using Zoom Tool. To get the job done

- The Zoom Tool will be selected, if it is clicked in

the Zoom Tool box. f S

- After selecting the Zoom Tool, if the mouse P
pointer is brought on the screen, it will look like & L;u""l,l t_j\
flint-glass, and a phus (+) sign will be visible in N a
the glass.

- The size of the screen will be bigger when clicked with the Zoom Tool on
gereen, With the increasing size of the screen, the object will remain on the
screen enlarged. If it becomes enormously enlarged, some objects will not be
viewed on the screen. Clicking on the screen and dragging with the
hand-tool, that part can be brought on the screen.

= Press the Alt buiton while the Zoom Tool is active, and the Zoom Tool will
be transformed into the Zoom Out Tool. Keep pressing the Alt button and
contimie clicking with the Zoom QOut Tool, the size of the screen will
gradually become smaller.

- Press Curl - or Cirl = button to complete the work of Zoom out and X
Zoom in. R
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Changing the Positioning of Page By Hand Tool

If the size of the page is made smaller or bigger, the necessary part of the object

can go outside the visible area. In this case, to shift the object to a suitable place

on the screen

- Select the Hand Tool by clicking on it in the Hand Tool Box.

- Click on the necessary object with the Hand Tool, dragging it to a suitable
place, and release the pressure of the finger on the mouse.

In this way, the positioning of the original page can be changed. The object

that has been clicked will not be shifted in a different way.

Mode of Viewing Object

There are some modes to view objects in the Illustrator programme. Any of these

can be selected from the View menu as required.

- In Outline Mode, the object is viewed as an outline or in a linear shape. In
this mode, editing of the shape or structure of the object, particularly a
detailed editing of a line or path can easily be done.

- The object is viewed perfectly in Pixel Preview or Preview mode.

- The image viewed in Overprint Preview Mode can be printed out.

Creating Object

In the preparatory stage of creating objects, the elementary process of making

different kinds of shapes should be learnt, for example, squares, rectangulars,

circulars, and elliptic, multi-angular, starry, and spiral shapes. To create an object

- The Rectangle Tool will be selected if clicked with the mouse pointer.

- After bringing the mouse pointer inside the screen and clicking anywhere,
drag diagonally below an inch and release the pressure on the mouse. A
square or rectangular object will be created.

In the same process, select another object tool from the Tool box and make other
objects. No object can be created only once. By erasing the object partially or
fully, we can start in a new way. To get the task done, it is required to learn how
to erase the entire object or part of the object.

Selecting Object and Erasing Borderline or Path

- Ifthe object is filled with color, the object will be selected if clicked with the
Selection Tool or Direct Selection Tool. Keep pressing the Alt button and
click on the path of the object. The entire object will be selected.

- To erase the path of the object or the part of the path, select them with either
the Selection Tool or Direct Selection Tool. Press Backspace or Delete
button, and the Path or the part will be deleted.
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If the Backspace or Delete button is pressed, the object is erased. Select the Cut
command from the Edit menu, and the object goes to a temporary memory called
clipboard and stays there until another object is cut or copied. When an object
stays on the clipboard, selecting the paste command from the Edit menu will
restore the object to the document.

Path

The path of the object can be formed with more than one segment. A single
segment can also be used if necessary. The border of the object is called Path.
A straight line is called Path too.

Selection Tool

- The selection Tool, Direct Selection Tool or Group Selection Tool can be
used to select either the entire object or a part of an object.

- The selection tool is called the Black Arrow. Click the Selection Tool with
the mouse pointer for using the tool, and it will be selected. If the mouse
pointer is brought on the screen after selecting the tool, the mouse pointer
takes the shape of a black arrow or selection tool. Click on the object and it
will be selected. Selection Tool is also used to select the entire object.

- If any object is selected with the Selection Tool, rectangular, circular or
bounding box is created around the object. Four hollow boxes on four
corners and four on the four arms will be visible. These boxes are called
Resize Box. Clicking and dragging on the resizing boxes, the size of the
object can be enlarged and reduced. Keep pressing shift and drag, and the
object will be bigger or smaller according to proportion.

- Clicking the centre of the selected object with the Selection Tool or on any of
the arms or any part of the object and dragging, it will be shifted to anywhere.

For selecting more than one object together

- After selecting the first object, keep pressing the shift button and select the
next object. In this way, select as many objects as required. When all the
objects are selected only one bounding box will square them.

- By clicking and dragging the resize box of the bounding box, all the objects
will be enlarged and shortened together.

- Click the mouse pointer on an empty space on the screen, the object will be
selection-free. If any particular object requires to be selection free from
numerous selected objects, click the object while pressing the Shift button.

Direct Selection Tool

The white tool on the right of the Selection tool is called the Direct Selection

Tool. This tool is called the White Arrow.
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The Direct Selection Tool or the White Tool is used to select the segment of the
object or the entire object. A part of the object can separately be enlarged or
shortened by selecting any anchor point of the object with the Direct Selection
Tool.

Grouping Object

To create a group of objects

A. Select either all or requisite objects.

B. The selected objects will be grouped, if the Group command is given from
the Object menu.

Clicking on a blank space, make all the objects selection-free, and then click any
object with the black arrow or the selection tool, and a rectangular bounding box
will be created around the grouped objects. Thus the objects inside the selection
box will be selected together.

To make the grouped objects ungrouped:
A. Click an object, and the grouped objects will be selected.

B. Give the Ungroup command from the Object menu, and the grouped objects
will be ungrouped.

Lock the Objects

While working with more than one object, it is required to keep one or more
than objects locked. As a locked object can not be selected, the editing work can
not be done. So the locked object can not be changed by mistake.

To lock an object:

A. Select a particular object.

B. Give the Lock command from the Object menu.

If it is required to edit or change a locked object, unlock it. To unlock an object

select the ‘Unlock All’ command from the object menu. Thus all the objects will
be unlocked. An unlocked object can be edited in the usual way.

Use of Cut, Copy and Paste Command

After selecting any object with the selection tool and giving the Cut command
from the Edit menu, the object will disappear and it will be copied if the Copy
command is given. Any cut and copied object is stored on the clipboard, and if
Paste command is given from the Edit menu, the object will be pasted on the
screen. The object can be shifted elsewhere by dragging it with the selection
tool.

If any object is dragged while Pressing the Alt button of the keyboard, it is
shifted after a copy is created.
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Give the Paste in Front command, and the object will be placed above the
existing object.

Give the Paste in Back command, and the copied object will be placed below the
existing object.

Layer

Layer means step. In this process, editing can be done while keeping different
objects on different steps. This layer or step can be compared to transparent glass
or polythene. If three objects or pictures are created on three glasses or
transparent media and placed on the other, three objects will be viewed. These
three glasses or media are regarded as layers.

The facilities of working in the layer process are as follows:

e Arranging steps among the Layers;

e keeping more than one layer invisible;

e keeping layers locked,

e Adding a new layer, removing unnecessary layers, etc.

Creating New Layers

If Layer palette is not viewed on the screen, give the Layer command from the
Window menu, and the layer palette will be viewed. At the beginning, only one
layer will be on the palette. After finishing the work of a layer, add a new layer
on the palette to create new object. To add a new layer

A. A new layer will be added on the layer palette when you click the Create
New Layer icon below the row of Layer Palette.

B. If any layer numbered serially needs to be identified with a particular
name, double-click the layer and a dialogue box called Layer Options will
be viewed. Type the necessary name on the Name box, and click the Ok
button. The serial number or name of the concerned Layer (if the name was
previously given) will be changed into the name typed in the dialogue box.

Cancelling Layer

A. By selecting the Layer and the Delete command from the pop-up menu on
the layer palette, the selected layer will be cancelled.

- In the process of deleting a layer of artwork or an object, a cautionary
message like ‘Delete Layer?’ will be viewed. Click the ‘Ok’ button, and the
layer will be deleted. Click the ‘No’ button, and the deleting process will be

stopped. But by clicking and dragging the layer, on to the Delete icon, no
such message will be viewed.
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Merging Layers

After creating and editing objects of two or more layers, they can be merged

together. To pet the job done:

A. Select the layers.

B. Select the ‘“Merge Selected’ command from the pop-up menu of the layer
palette, and the layers will be merged.

Use of Color In Object

After creating an object, fill in the color as required. The color palette, color bar,

or color spectrum bar, gradient, etc. are used to fill color in the object.

Color Palette

If the color palette is not viewed on the screen, give the color command of the

Window menu, and the color palette will appear.

- On the left above the Color Palette, an
itdicator box of Fill and Stroke or - : :
Swatch is found. Color Slider and Color | | #Cekr " Swatches ' A0

Spectrum Bar are found below it. If the E ; — | 00

work is done on gray scale mode, only
one color slider will be viewed. If the G ]
work is done on RGB = Red Green Blue
mode, 3 color sliders will be viewed, and

if the work is done on CMYK mode, 4 | |7} —— '
color sliders will be viewed.
Fill Color

To fill color in any object:

A. Select the object.

B. Click the Fill Indicator box of the
Color Palette, activate it. The
activated Fill Swatch will stay
above the Stroke icon.

C. Click the requisite color in Color Spectrum Bar,

The selected object will be filled with the color in Color Spectrum Bar. On

the extreme right of the Color Spectrum Bar, a Swatch of black and white

color will be found. If the black swatch is clicked, the object will be filled
entirely with a black color, and if the white swatch is clicked, the object will
be filled entirely with a white color.

e e——

9 Coler *Suicher N o)
E F_ X
< Iy

B __ G

e ——
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The Use of Stroke

The border of object is called Path. The meagurement of making a path thick or

thin ig called Stroke. Objects of grouped and ungrouped path, straight, curved

lines, ete. are controlled by Stroke. Controlling strokes meang to make a path
thick or thin and colored. Making a Stroke thick and thin can be done with the

Stroke Palette. To get the job done

A. Select the object or path. If the Stroke Palette is not viewed on the screen,
click the Stroke command from the Window menu, and the Stroke Palette
will be viewed.

B. When the object or path remains selected, click the downward arrow of the
Weight box in Stroke Palette and keep presging the mouse, many
measurcment units will be shown in the dropdown list, Select a number from
the list as required. If a small number is selected, the siroke will be thin, and
if a large mumber is selected, the stroke will be thick.

C. A measurement unit can be typed
directly in the Weight box, if E iy g e
required. The fraction of a mmmber T T T
can be used too. The thickness and s el QR
0-1000 points.

Pen and Pencil Tool

The main reason of the Ilustrator programme being popular is the use of Pen
Tool. It is possible to make complex and very small design and do the editing
work with the Pen Tool.

Two anchor points are found at the two ends of a path or line. The first anchor
point is called the starting point and the second anchor point is called end point.
There iz a controlling handle with the anchor points of curved path and a
control point outside the control handle. By clicking and dragging the control
point, the curve of a line can be controlled. The anchor peint, control handle, and

control point are not viewed in the print out.
The Peneil Tool is another form of the Pen
Tool. Curve lings can be made by
dragging the Pencil Tool.

The Pen Tool ig the main tool for drawing R
vector objects. A subtle object can be , TSR

created by a keen path with the help of the

Pen Tool.
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Closed Path and Opened Path

A closed Path has no beginning and no closing point, as in a circle and square,

etc. A closed path may have curved ends. On the contrary, an Open Path has a

beginning and a closing end.

Pencil Tool and Pen Tool

A Path can be created easily with the Pencil Tool. By selecting the pencil tool

from the tool box, and clicking and dragging it on the screen path, a drawing

curved line is possible. The function of the pencil tool is like making a sketch on

the paper. On the contrary, a path is created with the Pen Tool by clicking and

dragging. To make a path with the Pen Tool

A. Select the pen tool from the toolbox. Click anywhere on the screen and
release the pressure of your finger from the mouse.

B. Click a little bit above for the second time and release the pressure of the
finger from the mouse.

C. Click on the right below from the place where you have clicked for the
second time.

D. Click above the right a bit, and drag rightward.

E. Click on the right a bit below, and click again on the right from the position
of next, moving a bit rightward from the previous click.

F. Clicking on the right above and drag further right from this position

G. Click on the right below.

A wave-like open path object can be created in this way.

Editing Path

A path cannot be created according to the expectation at the first attempt. After

creating the path, give it the expected shape through editing. By editing the path,

new anchor points can be added, and it can be removed if required or Cropped

up or the two separated parts can be connected too. In this way, a change can be

made as many times as required.

Adding Anchor Point : e N

To add an anchor point at any point of the path: | /' [

A. Select the Add Anchor Point Tool from | / |
toolbox, and bring the mouse pointer
inside the sereen, a plus sign (+) will be found on the right below the Pen Tool.

B. Click any place of the path with the Anchor Tool Point, and a new anchor
point will be set on that point.

- The new anchor point added on the straight path is called a Straight Comer
Anchor Point and on the curved path is called a Smooth Anchor Point.
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Removing Anchor Point

To remove any anchor point on the path:

A. Select the Delete Anchor Point Tool. After selecting the tool, bring mouse

pointer inside the screen, and a minus sign (-) will be viewed below the Pen Tool.

B. If you click any anchor point with the Delete Anchor Point Tool, that anchor

point will be deleted.

Editing Curve Path

A circle/rectangular object or a design will be created with the pen/pencil tool

for editing path. To edit curve:

A. Selecting the Direct Selection Tool and after clicking an anchor point, drag
and shift its position, and the curve and shape of the anchor will be changed.

B. Click an anchor point, and the handle of it will be viewed. Clicking and
dragging the control point of any end of the handle, the part of the path
related with the anchor point, and the curve can be reduced or increased. The
direction can be changed too.

After creating open path with the Pencil or Pen Tool, the strokes can be thick or

thin, and filled with color. After creating closed paths with the Pencil or Pen

Tool, it can be filled with any color.

Writing Job

Writing is mandatory for the covers of books, magazines, posters,

advertisements, cards, etc. The Type Tool is used for writing in Illustrator. Six

kinds of Type Tools are found in Illustrator. Arrangement of writing can be done

in three ways with these Type Tools, for example, Point Text, Area Text and Path

Text.

Point Text

In the Point Text process, the way of typing is very easy. To type in this process:

Select the Type Tool from the toolbox.

Click any blank space of the screen.

Change the keyboard into Bangla for typing in Bangla.

Click ‘Character’ in ribbon on the screen, and the Character Palette will be
viewed. Select the font from the Font Pop-up menu of the Character Palette.
Start typing following the rules of word processing. Click any letter with
the Selection Tool, and a line will be viewed below it. This line is called
‘Baseline’.

Editing Writing

The requisite commands will be found in the Type menu and in the Character
Palette.

o 0wp

=
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Select the Character from the Type command of the Window menu, or press Ctrl
T, and the Character Palette will be viewed floating on the screen. When it is
floating, it can be used as required,

Selecting Letters :
Letters, and words can be selected according to the |°="=ncr= [EASScRses =
rules of word processing while the Type Tool | >Scrmvitfesu= o

is selected. Click with Direct Selection Toolin | ™

the writing, the entire typed part i.. the entire | T = == -~ & = Bl

writing with the baseline will be selected. In this | =~ © ~ =

case, the letters will not be highlighted. The I i dlid 1t iR

baseline under the letters will not be viewed. | & = °= .~ ® -~

Changing Color of Letters Sl bt

To change the color of the letters: s e

A.The requisite letters or writings should be selected.

B. Click on the color on the bar of the Color Palette or Swatch Palette. The
selected letters or words will assume the color,

Deleting Letters

A letter or letters or a paragraph or the entire writing can be deleted by pressing

the Backspace/Delete button, if it is selected.

Enlarging or Reducing Font Size

A, Click the downward arrow on the right side of Font Size box in the Character
Palette as the letter or letters are selected and keep pressing the mouse, and a
list of measuring numbers about the Font Size will be viewed. Continue
pressing the mouse and take on a measurement number, and the number will
be selected. After giving the command, release the pressure on the mouse
and the size of the selected letters will either be enlarged or reduced.

B. If the requisite measurement number is not found in the drop-down menu,
place insertion pointer in Font Size box by clicking directly.

- By pressing the Backspace button, delete the existing measurement number
and type new number.

- Press Enter button and the selected letter or letters will either be enlarged or
reduced according to the measurement number,

Increasing or Decreasing Font Size Vertically and Horizontally

To get the job done:

A. Click the drop-down arrow on the right of Vertical Scale and keep the
pressure on the mouse to get the list of measurement numbers. If a number
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bigger than 100% is selected, keep the pressure on the mouse and drag. The
font size will be vertically big. On the contrary, if a number smaller than
100% is typed, the font size will be vertically small. 100% is the ideal
measurement of letter.

To increase or decrease fonts horizontally:

B. Clicking the drop-down arrow on the right of Horizontal Scale and keeping
pressure on the mouse to get the list of measurement number. If a number
bigger than 100% is selected, keep continuing the pressure on the mouse and
keep dragging. The font size will be horizontally big. On the contrary, if a
number smaller than 100% is typed, the font size will be horizontally small.
100% is the ideal measurement of letter.

Baseline Shift

If any text written with the Direct Selection Tool is selected, the line seen below

the text is called the Baseline. Shifting the lower edge of the text up or down is

called Baseline Shift.

Selecting the measurement number from the drop-down menu in ‘Set the
Baseline Shift box’ of the Character palette, or typing measurement number
directly in the Set the Baseline Shift box, the measurement of Baseline Shift
should be fixed. The use of a negative number will take the text below the
baseline, and conversely an positive number will bring the text above the
baseline.

The Leading

The space between the lines is called the ‘Leading’ which can be required for

the text containing many lines.

A. By selecting a measurement number from the drop-down menu in Set the
Leading box of the Character palette, or typing the measurement number
directly in the Set the Leading box, and pressing the Enter, the Leading will
be activated.

B. If the upward arrow button of Set the Leading box is pressed, the
measurement of the Leading will increase, and if the downward arrow button
is pressed, the measurement of the Leading will decrease.

Area Text

Any text typed or placed in square, rectangular,

circular, elliptical or any closed path is called Area

Text. To type or arrange text in a closed path:

A. Create a square, rectangular, circular or
elliptical path.

B. After selecting the Type Tool, place the
mouse pointer on the closed path, the Type
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Tool will take the shape of the Area Type Tool.

C. Click on the anchor point of the path, and the insertion point will be placed
inside the closed path, which will be used as a Text Box or Text Container.

D. Start the work of typing.

E. When you will reach the right edge of a line, the insertion pointer will
automatically go down the next line. If typing continues in this way, the
next line will be automatically started.

Typing in the Path

Typing inside and outside the closed path, and below and above the open path

can be done with the Path Type Tool of Illustrator. Typing inside and outside a

circular object like making a monogram can be done.

Typing outside Circular Object

A. Make a circular object, and if it is filled with color, click the None icon either
of the Color Palette or Tool Box to delete the color of the circle.

B. Select the Type on a Path Tool from the Toeol Box

as the circle is selected. Click the anchor point of o oot W%

this circle with the tool, and the insertion point will & ;ﬁ%

be placed outside the Path of the circle. & s
- The circle must be selected while clicking. If it is % ¥

not selected, step 1 and step 2 should be completed
after the selection.

C. If typing is started, the text will advance following the path of the circle
usually from left to right. In the same way, the text will be arranged outside
rectangular object if required.

D. Click the text with the Direct Selection Tool and the Eyebeam between the
Path and the text will be selected.

E. By clicking the edge above or below the Eyebeam and dragging it in a
circular way the text can be shified elsewhere.

Arranging Writing in Open Path

A. An Open Path can be created with the Pencil or Pen Tool.

B. Click on the selected Path with the Path Tool, and the insertion pointer will
be placed on the Path. .

C. Type following the usual rule. PRLot @"9

- The Path and the Text will be selected | &~ ey oy g 5
if the text is clicked with the Direct
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Selection Tool, and the fext can be shifted elsewhere by clicking and dragging
the Eyebeam while selected.

- The Path will be selected if clicked with the Direct Selection Tool, and the
anchor point of the Path will be viewed. Now the Path can be edited
following the rules of editing. If the Path is made curve, the text will follow
the line.

- If the Path is smaller than the text, any additionsl text will not be viewed.
When the Path will be extended, the rest of the text will be viewed.

Creating Outline of Letters

When the outline of letters is created, the edges of the letters will be transformed
into a Path. By clicking and dragging the Path and Anchor point, the shapes of
the letters can be changed. ] ) i

2

A. Select one or more than one letter | | r L%
or word. :

B. Give the Create Outline command from the Type menu or press Shift Cirl O,
and selected text will be transformed into the Qutline.

When the letters will be transformed into the Outline, the text will be changed

into graphics. The shape of the letters can be changed following the rules of

editing a Path, filling color and adding gradient.

Placement of Image in Mlustrator

To place an image in illystrator;

A. Give the Place command from the File menu and a Place dialogue box will
come.

B. Select the required file from the Place dialogue box.

- It should be known in which folder and under what name the file has been
saved. The required file will be selected after opening the specific folder.
C. Click the Place bution in the dialogue box, and the mage of the selected file

will be viewed on the screen.

- A cross sign will be viewed on the image when the image of the Photoshop
is placed in the Oinstrator. Click outside and the cross-sign will be removed.
Click the image with the Selection Tool, and the image will be selected and
four resize boxes on the four arms and on the four angles will be viewed. By
clicking and dragging the resize boxes, the images can either be enlarged or
reduced.

* Becmyes of the vergion of softwar: there may he difference in tithe and meny har,
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Exercise
1. How many forms of media are combined in multimedia?
Al B. 2
C.3 D. 4

2. In which work is multimedia used?
A. For preparing an examination result; B. For calculating shopping expenditure;
C. For preparing a scoresheet of cricket; D. For making an animation film;
3. Which one is a multimedia Software?
A. Microsoft Work B. Microsoft Powerpoint
C. Microsoft Excel D. Microsoft Access
4. Application of Multimedia—
1. has made the presentation of text impressive;
ii. has made the work of printing and publication easy;
iii. has made the keeping of accounts easy;
Which one is correct?
A i&ii B. i &iii
C. ii &iii D. i,ii &iii
Read the chapter below, and answer the question nos. 5 & 6:

Mr. Rakib is the chief executive of a renowned company. A foreign delegate
will come to visit his company tomorrow. He has made a presentation in his
laptop and he will show it to them. He took the help of a piece of Software for
the presentation.

5. Which Software is suitable for Mr. Rakib for his representation?
A. Microsoft Word B. Microsoft Powerpoint
C. Microsoft Excel D. Microsoft Access
6. The Software which is used by Mr. Rakib—
1. will make the presentation impressive by using animation.
ii. will show the activities of the company by using sound and video.
iii. will prepare the accounts of his company.
Which one is correct?
A i&ii B. i&iii
C. ii&iii D. 1,1 & iii
7. Explain the importance of Presentation Software to present anything.

8. ‘The present publication industry is completely dependent on Graphics
Software,” explain with reasons.

Forma-15, ICT-9-10
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Afiter completing this chapter, we will be able to-

» analyse the concept of database;

» describe the techniques of the Database Management System (DBMS);
> expalin the importance of using Database Management System;

» prepare & database by using the software.
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The Concept of Database

Database is called the storehouse of informatfion. It is a computer oriented
process by which collected information can be stored and recollecied whenever
needed. In other words, a database is a store of collected data from where
information can be collected in different ways to make important decisions. In
simple terms a database is an organised list of voluminous data from where a
requisite data is identified and picked out easily and quickly. In this storchouse,
voluminous information of different kinds can be saved. Users can collect any
mformnhunﬁumthmstureatmyhmeaaperﬂmrreqmmﬁmﬁdatahasem

3 1 Ble Ede  Vew [nsert  Fgrmat  Becords  Jools  Window  Help

2= RENPE W | LOL L) e 0 o | 0 | b b
Sl Mo | Name | Age | Date of Bith |  Willage | Union |

| |1 Abul Kasam 27 221960 Tepra kanaihat

| |2 M. A Walek 18 111990 Manda Bhasantara

| i3 kKuddus Miah as 2/41973 Basail Raukhali

| |4 Hamid Sheaik 50 FAMNGS5T Dhakpara Dishanchar

| |5 Habib Uddin Miah 30 2518978 Dhakpara Dishanchar

L_ |6 Rahim Choudhury 28 3MBM13981 Basail Raukhali

also called a *Database Management System’ (DBMS). As the data saved in the
information storehouse iz used in different kindz of management work, it is
called the Database Management System (DBMS). Clasgified information is
stored in different files with different names, So the requisite information can be
found easily.

A database is usually formed with columns and rows. Every columm has a
heading that indicates what type of data it contains. The headings are recognised
as fields. A row is formed by some columns which are placed side by side. Each
row is called a record,

Every column that containg Serial number, Name, Age, Date of Birth, Village,
Union ete., is a field, and under these fields data, such as Abul Kasem, 27,
2/2/1960 Tepra Kanaihat are listed. Several fields, taken from the same row
comprises & record. The database above has 6 fields end 6 records.

Data have been preserved in datsbase files in computer since the 1960s. Back
then, a database was formed with a data table, but now the concept of databaze
has developed in many respects. Nowadays, one or multiple files of data tables,
query, form, report, maxo, module, etc., can be saved under a databage. So
database is one or multiple files enriched with data or information. Some
essential database programmeg are Microsoft Access, Foxpro, Debase, Foxbase,
Oracle, Fourth Dimension, Paradox, etc.
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Characteristics of Database Programme

Voluminous data is stored in an organised way by preparing tables in
database, which can be used whenever required.

The accounts of industries, inventory management, annual report,
production and sale accounts, etc., can be stored and controlled easily.

Any required information from the enormous database can be traced out
easily.
It is possible to prepare a report with the necessary records from the
mammoth store of database. Graph, chart and picture can be inserted into the
report.

It is possible to create a mailing label with the necessary records by taking
them from the database.

The data entry is made limited by imposing conditions in fields for avoiding
mistakes while making entry in the database programme. It is called input
validation. Suppose that entry is being given to a salary field of a data table
where minimum salary is Tk 2000 and maximum is Tk 11500. If a condition
of the input validation of >=2000 and <= 11500 is given in this field, no entry
will be accepted below Tk 2000 or above Tk 11500. An error message will be
shown, if such as entry is made.

A Data table can be created by separating records from the database by
imposing conditions in the query.

A relation can be created to exchange data between two tables on the basis
of certain fields.

An index is used to find out information from the database. If any index is
created on a field, the value and the record-reference of the field is arranged
in an order. An index file can arrange the records in different ways without
changing the original data file. One can easily find a topic, just by seeing the
content of a book. In the same way, it is possible to find information easily
even from a database.

It is possible to create a link among the files. So, when a piece of information
saved in a linked file, it will be updated automatically in other linked files
too.

The record structure of data in a database can be changed if necessary. When
some pieces of work need to be done repeatedly, a Macro can be created
collectively with these jobs, and transforming those into a single action, it
can be used repeatedly. It saves time and the users do not do the same work
repeatedly.
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The Concept of Database and Access

The work of a database is done in a microcomputer mainly with Microsoft
Access software which is a popular database software created by the Microsoft

corporation.
Preparation for Starting Work in Access Programme

Microsoft Office Access needs to be installed in the computer for doing the work
of database with Access programme.

Opening Access Programme

To open Microsoft access programme:

1. Click the start button by taking the mouse
pointer on it below the left comer of the New Blank Database
screen, and a menu will appear on the :

screen. BN
2. When the mouse pointer will be placed

on All Programmes of this menu, another

menu will be visible. Blank Database

3. By clicking the Microsoft Office, you will
get a list of programmes of Microsoft
Office in another menu,

Create a Microsoft Office Access database that does

5. If you select the Microsoft Office Access | ot contan any exsting data or sbjects

Blank Database

command from this list, it will open. File Name:

6. Click on the icon of the Blank Database | "' =
on the lefi side above the Microsoft Office | =" 7ol
Access window and put the filename of in | | cese | | conel |

the blank dialogue box. Type ‘Practice-1°.

7. Click on the folder icon of the right corner of the File Name edit bar.
‘Practice-1’ will remain as the new file name in the dialogue box. If it is
required to save in any folder, create that folder.

8. If you click on the ‘OK’ button in the dialogue box, the previous dialogue
box will be restored.

9. If you click on the ‘Create’ button in the dialogue box, a blank window will
come for creating tables. ‘Practice-1: Database ...” will be written on the title
bar of the window.
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-D.‘-.f'-." u Yy fu = Table Tools Practice-1: Databese (BSccess 2007T) - Microsoft Access
T b :
—-“"r Home Creste External Dets Datebase Took Acrobak Datasheet
_ —'-'IE =] 3 Insert Dala Type e iT] Linbgaie —-l{!;‘ nuj
M --"J 3§ | L &' nelets F | Furematei [ER:TT = ==
Wiy Hew d Existing Lookup = = - - Relstionshups Droject
g I Flehds n =l Renam LSRR = Dependend
Ly.! Flehds & e E Tyoe & meatt Rlelat Fip
Al Tables = | | ] Tames
Tablet x| o - Add Méw Fed
2 Taneet : Table * | Hew)
&
Creating Database Table

Creating the Database Table will be started from Practice -1 window. To do this:
1. Select ‘Design View' from the drop-down menu of *View’, and the ‘save ag’
dialogue box will come. In the dialogue box of table name, “Table-1" will
be written. The database table will be saved under this name, Click the ‘Ok’
button fo save the name of the table, 3

ave Az s ey
2, The window of the ficlds of the S_ -
database table will come. TE';TE"I‘E*““
3. Press the *Tab’ button after typing a
serial number in the cell of the field | [ Caneel |
name, the cursor will go to the cell of

‘Data Type". If you click in the drop-down arrow in this cell, a list of different
typesofdatam]lbemewedsuchastext,munber,cmmncydakfhme ete.

- Select the requisite datu.typeﬁ'um M ——— e
this list. If ‘number’ is selected, [“& =
calculation can be done with the data [== === mmee—
of this field. Age can be calculated —
based on either on the date or time or =
information of the data feld. =
Mathematical works like summation, e o
subtraction, multiplication, division, =
etc. cannot be donme with a letter = e
criemed data field ™ 00 L | e

- With the selection of the data type, aumenﬂleraapeclxnfﬂleda‘tamthncellu
below the field properties should be selected too. For example, in the right
cell of Field Size', it must be mentioned how big the size of fields and what
the other aspects will be. The field has its an own standard. It can be changed
if necessary.



2023

Use of Database 119

The field size should be bigger than the requisite size so that data cannot be
destroyed, but it should not be unnecessarily big in size.

4. After typing the field names and clicking ‘View Icon’ or selecting ‘Datasheet
View’ from the drop-down view on the left comer above, a dialoguse box with
the saving command will appear.

3. If you click the “Yes’ button in the dialogue box, *Datasheet View' or ‘Table
1 View' window will be visible, and the data will be entered into this
window.

Data Entry
The first field of *Datasheet View’ always remains selected. If it is not, select it
and complete data entry by typing in the usual system of word processing.

Tamig Taai Practice-]

Datakhae A eta JHIT) = Rlig it o sia

The font, font size, etc. can be selected before or after data entry. Press the “Teb’
button after the completion of the typing of data of a ficld to take the cursor to
the next field. After typing the data of the last field, press the ‘Tab’ button of the
keyboard, and the cursor will go to the first field of next record. Creating a Table
or Database will be completed in the same process. Keep in mind that you have
to save data at regular intervals, and to do the job, click ‘save icon’ or give the
‘save’ command from the drop-down menu of the office button, or press Ctrl 8
button.

The above database table can be created according to the described process.
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Changing Font Size

If you change the font size while keeping the insertion pointer in any cell of the
table, the font size of the whole table will be changed. The font size of a single
cell cannot be changed separately.

Correction of spelling error

Take the insertion pointer and click it to the cell where the correction of a

gpelling error is required. Following the general rule, type the correct spelling of
the word.

Closing and Opening of a Database File

It is impossible to enter information, make corrections and do the editing at a

time in a database file when the bulk of data is large. So, what is possible to do

at a time should be done, and the file will be saved and closed. The rest of the
work will be completed after opening it again.

To open a closed file

1. Enter the folder in which the file is saved.

2. Select the file the clicking on it. -

3. Click the open button on the menu bar above, e
and the database file will be opened.

4. Double click on the *“Table’ left, the tsble b
prepared as database will open. |

The next phaze will be started from here. -

Inserting New Field and Column to Table

To insert new ficlds into database table:

1. If You Click either “View’ icon or select “Degign View’ from the list of
“View Drop-down’, you will see the “Degign View” window.,

3. Click ‘Design’, and the ribbon of the ‘Design Menu® will be exposed. Click
‘Insert Rows’ and a new field will be inserted above the cell where the
insertion pointer stays.

4, Suppose that Male/Female will be typed as the name of the new field.

- Click the ‘View’ icon or select the ‘Datasheet View’ command from the list
of ‘View Drop-down’, and a message box for saving the field will come.
Click the “Yes’ button of message box.

Getting back to the datasheet window, you will find that a new field named
"Male/Female’ has been inserted. You have to give input into the field.
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Delete Field or Column
To delete an unnecessary field:

1. Select the field. Put the insertion pointer on the field and it will be
transformed into a downward arrow. Click and the whole column will be
selected.

2. Click either the ‘Delete’ icon of the ‘Home’ menu or on the ribbon of
datasheet menu. The whole column with the entire field will be deleted.

A cautionary message box will come before the deleting command is carnied out.

Click “Yes' button and the selected field will be permanently deleted. Once

deleted, it cannot be restored.

Deleting Records or Rows
To delete records or rows:

1. Select the record or row. After taking the insertion pointer at the extreme left
of the row, click the mouse, and the whole row will be selected.

2. Click the ‘Delete’ icon on the ribbon of Home menu and a cautionary
message box will come before the deleting command ig carried out.
3. Click the "Yes’ button and the selected row will be permanently deleted.
Once deleted, it cannot be restored.

Alphabetical and Cardinal Sorting of Data

The entire database can be sorted alphabetically and cardinally on the basis of
gither a field or a colhumn after preparing a table. Alphabetical and cardinal
gorting can be done in both Ascending and Descending orders. Ascending
Order means sorting from small to lagre order (A... B... C... Z, 1... 10... 50...
100) and Descending Order means gorting from large to small order (Z...C .. B
A, 100..50 .10 ...1).

The datafield of names, villages and
unions can be sorted alphebetically
and the datafield of serial numbers,
ape and date of birth can be sorted
cardinally.

Put the insertion pointer in any cell of
the field to sort the data of a table on
the basis of the age. Click the
Ascending icon on the ribbon of
Home meny, and the entire data will
be sorted in Ascending Order

Forma-18, ICT-3-10
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according to the age. Similarly, if you click the Descending icon, all data will
be sorted as per age.

The record will appear differently after the sorting of data, but the other
information will remain unchanged. For example, after sorting the data in the
Ascendmg Order on the basis of age, the record of number 11 gets on the top of
the table as he is the youngest of all. We will see that the other information
remains unchanged. If the change is donme mistakenly, give undo command
immediately. The record will be restored.

Searching Information

To find out the name of & particular person from a database containing & huge

bulk of data:

1. Click the *Find’ icon on the ribbon of ‘Home’ menu, and you will get the
‘Find and Replace’ dialogue box.,

2. Write the name or part of the name of the person to be searched on the
‘Find What" edit bar of the dizlogue box.
- A part of the name, either the title or sumame can be typed.

3. Select a name from the list of “Look in drop-down” of the dialogue box.
= From the liat of “Match drop-down’ aelect ‘Any Part of Field".

4. Click the ‘Find Next’ button of the dialogue box.
-As soon as you click, the
name, title or surname typed | -
in the cell of ‘Find What’ |
will be selected. If the word
is a title or part of many
names, click the “Find Next’ Vg | Iyl
button again. In this way, the e |l —
nexi name having the same i | M
part c¢r title will be selected. iy |l
By clicking repeatedly the “Find e | PO
Next” button, all the names il .
can be viewed. When the last Rk % vimom
name is viewed, a
confirmation message about
the completion of finding out
names will come. If there is no need to find out any more names, click the
cancel bution of the dialogue box.

2023
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Searching Conditional Information

It may be required to find either the information of the people of village "‘Nanda’,

or the union of ‘Raukhali’, or people’s age ranged from 30 to 60, or people

below 18 years of age, ctc. Besides, a more specific information search may be

required, and it is very casy. After inserting the congditions and giving the

command, the information covering the conditions will be viewed on screen

inatantly. Searching conditional information are shown below:

Searching records of people whose ages range from 30 to 60.

To find out their records:

1. Put the insertion pointer in any cell of the ‘Age’ field.

2. Click the 'Filter’ icon on the ribbon, and the Filter diglogue box will be
viewed on the screen.

3. Select “Between’ from the
“Number Filters’ drop-dowmn menu
of the dialogue box, and the
‘Between Numbers’ Dislogue box
will come. febers e e

4. Aftr typing 30 in the ‘Smallest’ || =T
cell and 60 in the largest cell in the N -
‘Between Numbers’ dialogue box,
click the Ok button.

5. The records of the people aped
between 30 to 60 will be viewed
on the screen.

To undo the conditional records, place || | smalest: 30

the mouse pointer on the “Toggle ||| Larcest 60

Filter’ icon of ribbon, and theiconwill ||| | oK | | ——
work as ‘Remove Filter®, If you click
now, the conditional

records will be restored to the |
previous state and the | MOt A ¥ DO LBIE S | e ilinge
“Toggle Filter’ icon will be B sl chae
tranaformed into an “Apply D AT Dhatous
Filter’ icon. Click the 'Apply
Filter’ icon to keep the
original amangement active.

1 Ttk

| Between Mumbers 7 X4

|
i
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Searching Information on the Basis of Village Name

There are names of four villages in sample database. Records of cither any of

the villages or two or three villages may be viewed on the screen.

To view any one of the four villages :

1. The records of the village you want to view, clicking the mouse pointer, put
the insertion pointer in the cell of the village. Suppose that the insertion
pointer is put in any of the cells of the village of *Basail’.

2. You will get 2 menu
by  clicking the
“Selection’ icon on
the ribbon, Select
Equals ‘Basail’ and
Containg ‘Basail’
from this menu, you will get only the records of the people of ‘Basail’.

- If you select Does not Equal Basail and Does not Contains Basail, the
records of other villages except ‘Basail’ will be viewed.

To undo or delete conditional records follow the instruction desctibed above.

Viewing Records of More Villages

To view records of more villages at a time:

1. If you put the insertion pointer in any cell of “Village Field’, a dorp-down
arrow will be added to the ‘Village Field’ at the right side. Click the
drop-down arrow, a short dialogue bex will come. Inside the dialogue box

2. Selecting ‘All’ and clicking “Blanks’
checkbox, remove the tick marks, Villsger = Union - Add New pieid

3. The tick marks in the checkboxes |/ ™77  «f =0'%F

beside the names of the village the | ot |

record of which you would like to | e

view will be kept, and the other tick | |

marks in the checkboxes will be | o

removed. Tt is viewed in the image at | ™" J Dhakpars

the right side that keeping the tick | ... -k

marks in the checkboxes of | e

‘Dhakpara’ and ‘Tepra’, the rest of the | .

tick marks will be removed. Dhakpara —_———

=1
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4. Clicking the "Ok’ [|= vwe’ 3 siieisiios”

b-um uf smbOK’ T Mt - Mamm - A I ——— .- Yillage -7 Iesicmy
i 1 KigSasm I 2/2/ 1960 Tepra Kl
m thﬂ mords 4 Hamid Shaik =0 /41957 Dhakpars Dilshanchar
H 5 Habib Uddin Miak 30 /51578 Dhakpara Diifhanchar
of the villages of g bt g , e
B Rishima Band ! WiF1982 Tepra Kanalhat
‘D > and v
an 11 khaken Molla 1 #/9/1993 Tepra Kanaihat
‘Tﬂpﬂ’ 14 Mimin Uddin Shefk 55 3/4/ 1553 Dhakpara Dighanchar
= an Mesd L3/1974 Tegra Eanaihat
M 179/ 1583 Tepra Kanalhat

1% Nagreen Choudhus 17 2/5f1960 Dhakpara Dighanchar

shown mmrds, follow 30 MishaMalllk 17 2/6/1881 Tepra

Searching Information on the Basis of Male/Female

There is a field in the database on the title of Male/Female, Only the records of
male and female can be viewed from thia database. In the field, M stands for
male end F stands for Female.
To get the information of only the female from thia database
1. Clicking the mouse 7w’ - o - :
pointer, put the insertion | " T UL RO e O
pointer in any field of “F’. e e B
2. Click the *Selection’ icon L5 dakn st : A LB
on the ribbon, and a menu 3 Mo s
will be viewed. =
- If you select Equals ‘F’ and Containg ‘F’ from this menu, only the records
of the female of different villages will be viewed on the screen,
Query and Report
Collecting and viewing conditional information are possible in query system
except the methods described above, but for saving conditional records and
taking print out, viewed information should be saved as query. Even, it will be
transformed as report to take print or supply as a printed matter. In query,
information is presented in an attractive way.
Collecting and Saving Information in Query Method
Suppose that collection and saving of information will be in the query process
on the basis of created table. To proceed with the operation:
1. Open ‘“Table 1° of datsbase. Only one table exists here.

2. Click "Query Design’ icon on the ribbon of ‘Create’ menu, 2 window of
collecting information in query process will come on the screen. ‘Show
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Table' dislogue box will || s 5o

come with this window too. '

. If you select “Table 1’ in the

‘Show Table’ dialogue box

and click the ‘Add’ button,

all the ficlds or headings of

table will be found included

in the field string.

. Now click the “‘Close’ button of the *Show Table’ dialogue box to close it.

. If you double click on a name of the field of the field box, it will come in the

first cell of the field string. In this way, all the fields can gradually be

included in the field string or only the necessary fields can be included. In
this sample, the fields of name, age, village, and union have been included.

. The field on the basis of which the information is required, add condition

in the cell of 'Criteria’ below the field, for example, several conditions can

be imposed on age factors. The information of the people above, below and
within a certain age limit can be collected.

A. If >30 is typed, the information of the people aged above 30 will be
collected. If >=30 is typed, the records of people aged 30 and above
will be shown.

B. If <30 is typed, the information of the people aged below 30 will be
ghown. If <=30 is typed, the information of the people aged 30 and below
will be viewed.

C. If>=30 and <=60 is typed, the records of the people aged 30 and above
and 60 and below will be showmn.

F Aﬂﬂ'typiﬂglhﬂmdiﬁonﬂ,c—ﬁck ) et T eyl

the ‘Run’ icon on the ribbon of | =~ " =

the ‘Design’ menu, and the
records on conditions will be

If you coolect information | 7 757 e

ﬂn-o-ugh the query process, the Kairman Nesa 31 Tegra Karizihat

title “Query 1’ will be shown

beside “Table 1°.

. Click the ‘Save’ icon, and the'Save ag’ dislogue box will come,

After typing a name of the query, for example, ‘Age Query’ in the dialogue

box, if you click OK button, ‘Query 1" will be changed to ‘Ape Query’, and

-------
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it will be enlisted in the database window. A Query icon will be shown with
the name of the query. Double click on the file of ‘Age Query’ in database
window, the file will be activated. As long as the file is active, prints can be
taken, preserved, supplied and distributed.

Collecting Information on the Basis of Villages and Unions in

Query Process

To collect information on the basis of villages and unions:

1. Select “Tsble 1* from the database window.

2. Click the ‘Query Degign’ icon on the ribbon of ‘Create” meny, and get a
diagram for collecting information, “Show Table’ dialogue box will come
with this diagram.

3. Belecting ‘Table 1’ in the ‘Show Table’ dislogue box, if you click "Add'
button, all the fields will be found included in the field string.

4. Clicking the ‘Close” button of the ‘Show Table’ dialogue box, close it.

If you double click on a name of a field of the field box, it will come in the

first cell of field string. In this way, &ll the fields can be gradually included in

the field string or only the necessary fields can be included. In this sample,
the fields of name, age, village, and union have been included.

6. The field on the basis of which
the information is required, add
condition in the row of ‘Criteria’ e
below the field. a0

7. Clicking in the row of ‘Criteria’ ot ot i
straight below the village field, -

8. Suppose that you have to collect | e .
the records of the village of || == B
Basail, Tepraand Nanda. Toget | ™
the task done
A. Type ‘Bagail’ in the cell of ‘Criteria’.

B. In the row below ‘Basail’, put the insertion pointer clicking the mouse
and type “Tepra’.

C. In the row below “Tepra’, put the insertion pointer clicking the mouse
and type “Nanda’,

- Quotation Marks will automatically be put around the names that will be
typed.

ol

b Waddal | L At Query | Query]
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. ¢ s r -
9. Click the I}un Igor o the T e =
nbeﬂ Ofth.e Deslgll menu aﬂer | MName - Age - Village - Union
typmg the COllditiOI]S. The i Kasem 27 Tepra Kanaihat
N Malek 18 Nanda Bhasantara
records will be shown on the Kuddus Miah 35 Basail Raukhali
* Rahim Choudhury 28 Basail Raukhali
screen as requ]ICd' Abdul Karim Khan 40 Nanda Bhasantara
10 Click the ‘Save’ icon, and the St e 23 epea it
" 5iog . | M A Kalam 16 Baszail Raukhaii
Save as dlS].Ogue box W]l]. come. Charubala Dasi 60 Nanda Bhasantara
. | Khokon Molla 15 Tepra Kanaihat
- After typmg a name of qucry, MA Latif 22 Basail Raukhali
for mple, ‘Village Query’ in Hanita Bagam 41 Nanda Bhasantara
» . . Kaiman Nesa 33 Tepra Kanaihat
the dlaloglle bOX, lf you CIICk Rahela Khatun 24 Tepra Kanaihat
the OK button, ‘Query 1’ Will be Narendra _Haid.r-r ‘i'n Nﬂnda Rhsqanf._ara
s Abdul Halim Biswas 63 Basail Raukhali
Ch&l]ged tO Vl]lage Ql.lel'y, aIld Misha Mallik 17 Tepra Kanaihat
it will be enlisted in the database | | **"" e

window. The Query icon will be
shown with the name of query. Double click on the file of “Village Query’
in database window, and the file will be activated. As long as the file is
active, prints can be taken, preserved, supplied and distributed.

=7 Tablet |51 Age Query | 5] Village .Quenr"i [d AgeQuery
E Age Query Thursday, Mféi:iﬁ
e : -
Name Age Village Union
Kuddus Miah 35 Basail Raukhali
Hamid Sheik 50 Dhakpara Dishanchar
Habib Uddin Miah 30 Dhakpara Dishanchar
Abdul Karim Khan 40 Manda Bhasantara
Charubala Dasi 60 Manda Bhasantara
Hanifa Begam 41 Nanda Bhasantara
Mimin Uddin Sheik 55 Dhakpara Dishanchar
Kaiman Nesa 33 Tepra Kanaihat
Nasreen Choudhury 47 Dhakpara Dishanchar
Arzu Miah 56 Nanda
: 10
Page 1ofl
Report

Usually information is supplied or distributed in a report format. Report can be
prepared cither on the basis of the entire database or on a query file. A report
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based on age query can be prepared. The file on which the report will be
prepared must be sclected. After the selection

1.

Click the “Report” icon on the ribbon
of the ‘Create’ men, and the window
of preparing report will be shown,
The fields of query files are kept in
order in this window.

. The sideways extension of these

ficlds may be wider than it is
required. To bring the measurement
in usual position:

. Select the field by clicking the name

of the field. For clicking and dragging
either the left or the right margin the

megasurement of the field can be
rednced or extended.

Besides, the page mumber below the

rep

ort, boxes of date and time at the

right gide can be reduced and extended
in the same way or placed in another
position by dragging.

Double clicking on the title of the report
it is possible to write in Bangla after

B.

Click the drop-down armrow of the
‘View’ icon and select the ‘Print
Preview’ command from the drop-
down memu. The prnt preview of the
report will be on the screen

If the presentation is not in the
expected order, click the *Close Print
Preview' icon on the ribbon at the
right side, and the report will be
restored to the ‘Layout View’.

T b S g Guery. T Wi ey | A Guimry

=y i =t
qurw Tehers o Rl

=

Thursdany, Wy 29, 2014

431712 PM
Kuddus Miah 35 Basall
Hariig Shisis S0 Dhakpaa Dhisharngiae
Habib Liddin Muah 30 Dhakpam Chishanchar
ADdul KarmEnan &0 Nanda Ehasantara
Charubala Dasi 60 Manda Bhasamtar
Hanifa fegam d41 Nanda hamntara
Alein Undden Shendk 55 Dhakpam hishamchar
Kalman Mesa 33 Tepma Kanaihat
MNasrean Choudhury 17 Dhakpara DMshanchar

!':..;:l |\ i ¥

Print Preview

Lk A : H—
U= Ay (A [
Print Size |Portrait| Landscape Margins
Prin Page Layout
b tunal ) (D e Ry
E e Iwe
TEC ] Do e
B fse Wy oy 35 2024
| —— n T B
B Deugn vew
o Frind W
Kuddiry Mlal 33 Basall aunnalh
Hamid Sheik W Llhh-ﬂ' thishant
[Hs Rt

Habbt Ls33i0 Mkt

If 1t 1s required to rearrange the size and shape of the field, do it repeatedly.

Forma-17, ICT-8-10



130 Information and Communication Technolagy

5. Before teking s print out, clicking the icons of gize, porireit, landscape,
margin oo the ribbon, the messurcment of page and marpm should be
adjusted as required. Then conneet the printer to the computer and click the
‘Print' scon el the printing will be started.

6. After the satisfactory editing work, click the ‘Save’ icon, and the ‘Save As’
dialogus box will be viewed.

7. In the *Save As’ dialogue box, type a name of the report, for example, ‘Age
Repoat’, and the click Ok bautton.

- The report file will be saved as *Age Report’ and will be listed in the database
window under the same name,

Adding Gridiines to Report =rress
Gridlines means a pattern made fiom hotizontal mnd i
vertical lines crossing cach other on the records. | _ - < SUET
Usualty gridlines stays under the field, but gridlines . - Calor -
can be added over and under the records and Gridlines
removed if necessary. To add and remove gridlines:

1. Click ‘Report Tab’ by pressing the right buiton of the moumss, and a
drop-down mesm will be viewed. Select Layout View', and the report will be
fransfremed in 8 layout view.

2, Chick ingide the report,

3. The tools of adding gridlines to the

T .
[ L LR R

ribbons will be active. = e o b )

4, Click the downward arrow below S P
the diagram of Gridlinea, samples of i
ﬁmt w uf Fiminus Iw.i]]. hﬂ [ J¥ = - AR R B massll B mlrgil
and Hm the m‘[ﬁﬂh Fiﬂinﬂs Bt Wi A arnda
will be selected. The eampls of Erarbits S @ dands S
mwﬂchwﬂlhcﬁmwﬂl raErTTR bEgET il T BNEERTIAC

3. Click the *Width’ drop-down armmow Rawen Comuihiry &7 Tretpers et
sarples of narrow and thick Knes
will be shown.

2028



2023

Use of Database 131

If a comparatively thick line is clicked, the gridline will be thick and on the
other hand, if a narrow line is clicked, the gridline will be thin.

6. Click the ‘Style’ drop-down arrow from the gridline toolbox to change the
style of gridline, the samples of different lines will be shown. The sample
which will be clicked, the gridline will be changed accordingly.

7. Click the ‘Color’ drop-down arrow from the gridline toolbox to change the
color of gridline, and a palette will be shown. The color which will be
clicked, the gridline color will be changed accordingly.

8. Click the downward arrow below the gridlines diagram from the toolbox to
remove the gridline from the report, and samples of different gridlines will be
shown. Click ‘None’ at the bottom of the sample. The gridline imposed on
the report will be removed.

After making the gridline thick or thin, imposing color on the lines and doing
other requisite works, click outside the top margin, and the selection of gridline
will no more be viewed.

* Because of the version of software there may be difference in title and menu bar.

Exercise

1. Which of the following is used to find out a piece of information easily
out of a huge store?

A. Database Software B. Spreadsheet Software
C. Presentation Software D. Word Processing Software
2. Which one of the following is used to fix the shape of a Field Name?
A. Create B. Field name
C. Field Size D. Design View

3. By using a Database Programme —
i. the annual accounts and the information on production can be preserved
easily.
ii. the presentation of information can be faster.

iii. the required records can be found easily.
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Which one is correct?
A 1&ii B. i&iii
C. ii &iii D. i,1i &iii
Read the paragraph below and answer the question nos. 4 & 5:

Maleka Begum is the owner of a Garments Factory in Bangladesh. She wants
to use computers for the smooth management of her company.

4. Which piece of Software is suitable for Maleka Begum?
A. Database Software B. Spreadsheet Software
C. Presentation Software D. Word Processing Software
5. By using the software, Maleka Begum will be able to —
1. keep the information updated.
ii. add new information.
iii. reduce the cost of office management.
Which one is correct?
A i&ii B. i&iii
C. il &iii D. i,ii & iii
6. Describe the process of inserting a new field in the above Database.

7. ‘Database Management can enhance speed in the official works of a
company.’Analyse.

The End
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